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Introduction 
 
The Inquiry Routing and Information System (IRIS) is a Web based, Internet messaging application.  
While it is assumed that IRIS is a form of e-mail, technically speaking, IRIS is not e-mail. The alerts 
sent to responders telling them that they have IRIS traffic is managed via e-mail, but those messages 
have links to get into the IRIS server to actually see electronic message content. The messages 
received by veterans saying that VA has response for them are e-mail, but those messages have 
links in them to the IRIS server to see the response.   Please remember that distinction.  All 
messages received from the public via IRIS and responses to those messages are made through 
encrypted connections with a secure Internet data server.  All message data and responses remain 
on the server.  All sensitive data is protected according to current VA standards.     
 
This manual is intended for any VA staff member responsible for responding to messages from 
anyone using the IRIS messaging application.  The manual contains information about: 

 accessing the IRIS 

 bookmarking the IRIS URL 

 launching the IRIS 

 describes the Inquiry Console home screen that appears after logging in and the information 
contained on that console including toolbars, the navigation and content panes, tabs and 
subtabs and also describes:  

o how to navigate the Inquiry Console Home screen 
o procedures for working with inquiries, including viewing, editing, and responding to 

inquiries 
o using FAQs and Standard Text responses and their hotkeys 
o using search features 

 customer entry on behalf of an inquirer/veteran 

 accessing other consoles/screens and features  

 glossary of terms 

 troubleshooting information 

 
Resources for IRIS Users on the IRISInfo Intranet website: 
Information about the IRIS, its background, and a host of useful documents can be found at 
http://vaww.va.gov/irisinfo.  There is also a direct link to this website via the IRISInfo Website Help tab 
that is available on any open inquiry.  Documents that all responders should utilize are: 

 IRIS Participants Dropdown List:  this document lists all mailgroups in the IRIS in order of 
appearance in the dropdown listings and also provides information about service areas 
and/or other special considerations 

 IRIS FAQs:  This document prints out the contents of all FAQs in the IRIS Knowledge Base 

 Standard Text (was Standard Responses):  This document prints out the folder, label, and 
contents of all Standard Text Responses available to responders. 

 Written instruction guide that contains screenshots, descriptions, etc. for using the IRIS. 
Documents can be downloaded to responders’ machines or viewed on the Website. To do a search 
of any documents, do Control+F to open a search box to help find what you are looking for; be sure 
that your cursor is on text in the content and not the text in the callout boxes. 
Documents are routinely updated to ensure their currency. The dates of the respective documents 
can be found at the top of the first page of each document. 
 

 
 
 
 
 
 

http://vaww.va.gov/irisinfo
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Launching IRIS to get started; required browser settings 

 
If your machine has already run the previous version, IRIS v8, you should have no problem running 
the newest version; however, if you can’t successfully run the IRIS, your Internet browser must 
be adjusted. Download the browser settings documents from 

http://vaww.va.gov/irisinfo/irisguides.asp.  (VBA employees should already have the IRIS listed in the 

VBA master menu with the browser settings adjusted.) In addition to the browser settings, the 
following must be set. 
 
On your Internet Explorer browser, you must have your Pop-Up blocker turned OFF, you must have 
a screen resolution of 1024X768, and you must allow files greater than 1000MB.  See below. 
 
 
TURN OFF POP-UP BLOCKER 

 
 
File Size Setting MUST be no less than 1000 MB; to check go to Tools>Internet 
Options 

 
 
Click on Browsing History Settings button on the General Tab 

 

Your pop-up 
blocker MUST be 
turned off for the 
IRIS screens to 
load. 

Browsing History 

Settings button 

http://vaww.va.gov/irisinfo/irisguides.asp
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First Launch:.  Enter the IRIS logon URL in your Web browser:  

 https://iris.custhelp.com/cgi-bin/iris.cfg/php/admin/launch.php 
(NOTE: you may have to type it in rather than cut and paste to make it work. ALSO NOTE: This url 
will only be used ONCE.  Subsequent logins must be handled by using the Start button. See further 
instructions on Subsequent Logins below.) 
 
You will begin at the IRIS launch page.  Click on the button labeled ―Install RightNow CX‖ (standard 
desktop configuration); do not use Thin Client unless you are sight impaired and require the blind 
reader version of the IRIS.. Once the launch is exacted, you will get to the login screen.  After the 
first launch, you will access the IRIS using your Start button.  See Subsequent logins section 
below. 

 
 
                                                               Launch Page                       
                                
 

Disk space to use should 
reflect 1024 MB or greater 

When this screen appears, 
click on the button labeled 
Install RightNow CX 

https://iris.custhelp.com/cgi-bin/iris.cfg/php/admin/launch.php
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Subsequent Log-Ins:  The Windows Start Menu should be used to log into the IRIS 
after initial launch.  See screenshots below. 
 
After you have launched the IRIS successfully for the first time, you should log in using your 
Windows Start menu, since RightNow will now appear as an option on the menu. Components will 
load every time you log in.  See below. 
 

               
 

OR 
 

Components will load 
when login is successfully 
in process. This load will 
occur each time you log 
in. 

1. Click 

Start,  
2. Click All 
Programs 

3. Click on 
RightNow 

Technologies 

4. Pick the link with the RightNow Technologies logo

  (NOT the RightNow online support link) 

The first launch url is no longer relevant.  Note 
that the there is now another url to get into the 
IRIS that automatically fills the Site field. The 
correct url that should appear in the Site Field 

is https://iris.custhelp.com/cgi-bin/iris.cfg 

 
 

https://iris.custhelp.com/cgi-bin/iris.cfg
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Minimizing the Browser Screen 
It is recommended that you minimize the browser whenever you will be inactive in IRIS during 
a work day rather than logging off the system.  Minimizing prevents the need to reload the 
temporary files every time you leave IRIS to conduct other activities.  If you will be gone from the IRIS 
for any extended period of time such as at the end of the workday, you should log off the system.   
 

Access Codes 
Your access codes consist of Username and Password, and are case sensitive. These are issued 
by the IRIS Administrators along with the licenses to use this system.  This version does not allow 
multiple logins using the same access code.  Individual access codes must be issued by the IRIS 
administrators. Once you have a username and password, you may subsequently change your 
password.    DO NOT CHANGE YOUR USERNAME; only IRIS System Admins should do this.  See 
Personal Settings section below for instructions for changing passwords. 
 
We do not have unlimited licenses, so please do not request more licenses than you need. If you 
need more licenses for staff, contact the VA IRIS System Administrators at vairissysadmin@va.gov  If 
anyone using the system ceases to use the IRIS for any reason, please notify the IRIS System 
Admins so that the license can be re-issued to someone else and their names can be removed from 
the IRIS Listserv announcements mailgroup and other internal records. 

 
 
Alerts regarding the Receipt of IRIS Traffic 

 
The alerts function must be set by the VA IRIS Systems AND by the responder.  The System Admins 
set your IRIS account to send alerts to you/your mailgroup to let you know that you have IRIS traffic. 
The ability to SEND the alert is controlled by the VA IRIS System Admins.  You must also adjust your 
personal settings to receive alerts. See Personal Settings section to see how to set this. If you or 
your mailgroup is set to receive alerts, each separate inquiry will generate an alert message. Note:  if 
a distribution group membership is incorrect or if the IRIS server or Exchange servers are having 
problems, alerts may not be sent.  You cannot rely on alerts alone to keep up with IRIS traffic alert.   
It is recommended that you log into the IRIS every day to ensure that nothing is left 
unattended; that is the only guarantee that inquiries will be addressed within required 
turnaround times.  
 
 Alerts arrive in Outlook mail; see example: 

 
 
The link embedded in the open message is to be used ONLY when you haven’t run IRIS 
version 8 before.  The link is https://iris.custhelp.com/cgi-bin/iris.cfg/php/admin/launch.php 
This link will install the software and get you to the log in screen for the first time. Once installed, do 
not use this url again. 
 

RightNow may appear as a menu choice above the Start 
button after the initial first time load, depending on the 
frequency of its use.  Start button opens the menu above 

the button. Click on RightNow  to open the IRIS. 

mailto:vairissysadmin@va.gov
https://iris.custhelp.com/cgi-bin/iris.cfg/php/admin/launch.php
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If you already have the software installed, go to Start> All Programs> RightNowTechnologies, 
and click the RightNow entry with the RN icon (NOT RightNow online support).  This will take you to 
the log in screen. The site field on the login screen should say https://iris.custhelp.com/cgi-bin/iris.cfg 
(NOTE: You cannot access the IRIS by typing this url in the address field of the browser. You MUST 
use the pathway with Start>All Programs>RightNow Technologies, RightNow to get to the log in 
screen.)  Be sure to enter your access codes with the correct cased sensitivity.. 
 

   
 
 

 
 
Each mailgroup has a specific e-mail address to which alerts are sent.  In some cases, specific 
individuals are listed in the IRIS as subsets to a mail group, in which case alerts can be sent directly 
to those individuals.  For an IRIS mail group to get alerts that there is IRIS traffic needing 
attention, the mail group must have the mail group members listed on the distribution group 
for the routing address in Outlook Exchange mail.  
 
The IRIS server passes the alerts to Exchange mail for delivery.  Only the Exchange mailbox owner 
or your local Exchange administrator can modify the distribution list to add or to remove names on the 
distribution group membership.  If membership in an IRIS mail group changes, the IRIS System 
Admins need to be informed to ensure the integrity of their IRIS memberships and passwords.  In 
addition, the local Exchange administrator or mailbox owner must be notified by the local mail group 
to alter the distribution list; the IRIS System Admins cannot perform this function in Outlook.  Below is 
an example of a distribution group: 
 
The example is the VA IRIS System Admin Group listed in the Global Address List in Outlook 
Exchange. When you locate the routing name, you right click and choose Properties. Then the 
distribution list appears.  The person shown as the owner, if any, should have the ability to click on 
the Modify Members and make the changes. If no name is shown, your local Exchange administrator 
will have to be contacted to make changes. 
 

 
 

 
Outlook Mail Address Properties 

Distribution 
Group 
Membership 

Find routing 
name in the 
GAL 

Right click on name and 
choose Properties to display 
Distribution group 

The Site field on the login screen should reflect 
https://iris.custhelp.com/cgi-bin/iris.cfg 
Be sure to enter your access codes in the correct case. 
 

Start – All Programs> - 
RightNowTechnologies, and click the 
RightNow entry with the RN icon.  

    (NOT RightNow online support).   

https://iris.custhelp.com/cgi-bin/iris.cfg
https://iris.custhelp.com/cgi-bin/iris.cfg
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Required Turnaround Time for Responses: 
 
The required turnaround time for responses is within 5 business days of receipt of the inquiry by 
VA, unless another specific policy is mandated by your business line or other line of authority that is 
LESS than 5 business days.  NOTE: The turnaround time requirement remains the same even if the 
inquiry is reassigned.  The count begins with the receipt of the inquiry or the veteran update to that 
inquiry.  Veterans are told that the response time is 5 business days, which begins with the date of 
submission.  
 
Since alert traffic is not always reliable, you must log in manually no less than every 2-3 days to 
ensure that nothing is sitting unattended. Logging in is the only certain way to know what inquiries are 
in your workspace and to respond to them within required timelines. 
 
Life Cycle of An Inquiry 
Inquiries are never closed until they are set to Solved after an action by VA.  Inquirers have 31 days 
from the last action on an inquiry to reopen it and add on more information.  If an inquirer continues to 
update the inquiry, the life cycle of an inquiry can be a very long time.  If the inquirer misses the 31 
day timeline, s/he has to open a new inquiry. 
 
Inquirers can also cancel an inquiry. There is a button on their acknowledgement messages that says 
―I no longer need a response to my inquiry‖.   If the inquirer presses this button, the inquiry will 
automatically be set to Solved and moved to the Solved basket of the mailgroup with jurisdiction. 
 

Personal Settings: Receive Alerts, Change Passwords, Change Open Item Tabs 
Location on your My Group’s Inquiries screen: 
 
From the My Group’s Inquiries Console, you can change your personal settings to: 

 Receive/not receive alerts telling you that you have IRIS traffic 

 Change Password 

 View Options to change the location of the tabs for the open items from the top of the 
screen (default) to the bottom of the screen. 

 Navigation Pane Options (DO NOT USE) 

 Add ins  (DO NOT USE) 
Note:  Access depends on level of permissions set by the Administrator.  Password changes may be 
made by the VA user and should match the strong password requirements that require no less than 8 
characters long, with a mix of upper and lower case letters, numbers and control characters.  DO 
NOT CHANGE YOUR USERNAME; this should be done by the VA IRIS System Administrators.  

 
To make changes: 

Modify 
membership button Owner Name; if no owner 

name is displayed, the 
Exchange administrator must 
make the changes. 
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To change Personal Settings (receive alerts of incoming IRIS traffic and toast 
messages) 

 
 
 

Toast Notifications; pop-up messages/announcements that appear on your screen 
Announcements internal to the IRIS that may be sent to specific IRIS groups or individuals are called 
―toast‖ notifications; these messages apply ONLY to the IRIS system and are not related in any way 
to regular Outlook email. Only designated persons and system administrators have permission to 
send messages using this feature; however, everyone is able to receive them.   
 
Toast messages appear as pop-ups that will display briefly on the staff members’ desktops when 
they are logged into the IRIS; no external alert messages are issued.  The message is displayed in 
a window on the lower right section of the display for several seconds until it fades away. These 
notifications also appear in your list when you double-click Notifications on the navigation pane, and 
they remain in your list until you delete them. 

Click on 
RightNow 
button 

Click on 
RightNow 
CX Options 
button 

To ensure the receipt of email alerts 
regarding incoming IRIS traffic, be sure to 
select these fields. 

To ensure the receipt/display of toast 
messages, be sure to select these fields. 
THIS SHOULD BE CHECKED IN ALL 
CASES. 
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If you have been sent a notification while you are logged in, the desktop alert appears when the 
Notifications list is automatically refreshed. The default refresh interval is fifteen minutes, but your 
administrator may have changed that interval. Alerts also appear if new notifications are available 
when you manually refresh the list.  

 
 
 
Sending Toast Notifications (requires specific permissions) 
 
You must have the appropriate privileges to be able to send toast messages. When you broadcast a 
toast notification to other IRIS users, they will receive that notification only on their open IRIS screens 
when they are logged in; messages appear as temporary pop-ups.  If a toast notification is sent to an 
individual user who is not logged into IRIS, the user will receive the toast message when they log in.  
HOWEVER, toast messages sent to ALL IRIS users in the system will only be received by 
users logged into the IRIS at the time the message is sent. Only the IRIS System 
Administrators should send Toast Notifications to ALL IRIS users.  Your profile may give you 
permission to send notifications to other staff members. If so, you can select the recipients manually 
or send a toast notification to all logged-in staff members. 

 
To send a broadcast notification  

  

1. Double-click Notifications on the navigation pane.  
 

 
 
 

    2.  Click the New button to open the Send Notification window. 

             

 

 3. To send a notification to all staff members in the IRIS system who are logged in, select Send To 
All (only system administrators should do this.  All others should select a specific person or persons.) 

4.  To send to selected staff members, click the To  button to open the Select Names window. 

Clicking on Notifications will open up 
your notification message history. 

1. Click on 
Notifications 

2. Click on New 
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a. Select one or more names from the list. To select multiple recipients, press Ctrl while making 
your selections. 

  
b. Click the To button to add the names to the field.  Click the OK button to close the Select 
Names window.  The names you selected appear in the To field of the Send Notification 
window.  Note: You can also type the first few letters of the name you want to send the notifica-
tion to in the To field of the Send Notification window. If only one staff member’s name begins 
with those letters, the field is automatically populated when you move to the Message field. If 
multiple staff members’ names begin with the same letters, you can select the one you want 
from the Check Names window that opens when you move to the Message field. 

c. Type your message in the Message field of the Send Notification window. 

 

     d. Click the Send button to the message. 
  

 

 Change Your Password:    

     
 

 Follow the steps to change your password as shown in the screen and click OK.                      

 
 
 
Change Location of Open Item Tabs that appear as you open items on your screen. 
 
Default setting: The tabs for items that are opened appear horizontally across the top of the My 
Group’s Inquiries screen: 
 

Double Click on 
Password on the left 
column. 
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To change the tab display for items opened on your screen to the bottom as they were in the 
prior IRIS version: 

 
 
The tabs will now appear across the bottom unless you change the default back to its original setting. 
 

 
 

The Inquiry Console Screen: My Group’s Inquiries Home Screen 
 
The Inquiry Console Home Screen Definitions and Terms 
 

Tabs for open items 
appear across the top 

Change Content Pane Tab 
Alignment to Bottom and click 

OK 

Tabs for open items will now 
open across the bottom of 
your screen as in the previous 
IRIS version. 

Select View Options. 
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The Inquiry Console is your point of access to all inquiries, and to the Answer/FAQ Knowledge Base. 
All customer inquiry requests are serviced from the Inquiry. This console provides the means for: 

 Searching for inquiries. 

  Editing inquiries to work on and solve inquiries. 

 Sending responses— including the procedure to send a file with a response.  

 Updating multiple inquiries, which is a feature you can use to take an identical action on more 
than one inquiry, such as closing out duplicate inquiries from the same inquirer.  

 Adding inquiries on behalf of veterans.  

 Getting to the Analytics/Reports feature if you have permission to use it. 
 

Key terms  
As you work with inquiries, you will want to become familiar with the following key terms. 
 
Console—A major window/screen display in the IRIS application. 
Contact—A contact is a person.  A person who submits an inquiry is an inquirer and also a contact.  
If the inquirer is not the veteran but inquires about a veteran, the veteran is also a contact.  Under this 
circumstance, a single inquiry may have two contacts: the inquirer and the veteran. If an inquiry 
concerns the representative of the dependent of a veteran, there will be three contacts: one for the 
inquirer, one for the veteran, and one for the dependent.  The contact record is the place where the 
definitive information about the person/contact is stored, and this is the place that contains the 
searchable PII fields for the contact.  Any inquiries from or about this person will show in the inquiry 
history for this contact record. 
Default response requirements—The maximum time allowed (in hours) for inquiry response and 
resolution within the operating hours defined by the organization. The default response requirements 
are used to measure responder performance in responding to and solving inquiries. The parameter 
set in the IRIS for acceptable response time is 5 business days.  If this threshold is exceeded, the 
inquiry listing will turn red on the Inquiry Console. 
Discussion thread—The list of all activity on an inquiry, including updates made by the inquirer, 
responses entered and/or sent by responders, and notes about the inquiry made by responders 
(never visible to veterans and other IRIS customers). All activity is listed chronologically and provides 
a history of each inquiry in the IRIS. 
Drill down—To start at a top or general level and become more specific at each lower level. The IRIS 
drill-down feature enables access to additional levels of detail on consoles, views, and reports.  
File attachment—A file that is attached to an inquiry by VA; NOTE: inquirers are not permitted to 
append files or documents to their inquiries for security reasons. Files that are attached to an inquiry 
response by VA can be accessed by veterans and other IRIS customers by viewing the answer on 
their e-mail clients. 
Inbox—A mail group repository for IRIS inquiries. The inbox contains all inquiries that have been 
assigned to the responder/responder group.  
Inquirer—A person/contact who accesses the IRIS to submit an inquiry via the web or any person 
who submits an inquiry to the IRIS via a call center, walk in visit, etc. 
Inquiry—Any question or request for help from a veteran or other VA Website customer through the 
Ask a Question feature on the IRIS homepage. Inquiries can also be added by responders on behalf 
of veterans on the Inquiry Console (most typically a feature used by a call center).  
Important Notes: 

 All status codes can be reset manually to another status code. 

 The IRIS statistically counts any inquiries with a status code other than Solved as an 
open inquiry.  Only inquiries that are in Solved status are considered completed and closed 
out. 

Multi-edit—A feature on a number of consoles for updating more than one inquiry at a time.  
Security profile—the level of access assigned to you by the IRIS System Administrators for you 
based on your skill set. Your inquiry console screen will display features to which you have access 
based on your security profile.   
SmartAssistant—An IRIS feature that searches the FAQ Knowledge Base to match keywords and 
phrases to existing FAQs and provides any of those FAQs to IRIS customers and IRIS staff as 
possible answers to inquiries..  
Solved—An inquiry status that is used when an inquiry has been answered and closed.   
Standard Text (Also called standard response) —Any text or response prepared in advance that can 
be sent to veterans and other IRIS customers when responding to IRIS inquiries. This text can be 
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appended to responses manually by a responder by selecting a prepared response from the 
Standard Text dropdown menu.  This answer can be amended by the responder to fit the needs of 
the response...  
Unresolved—An inquiry status type that automatically is assigned to a newly submitted inquiry.   
Updated—An inquiry status code that indicates that an inquiry has been updated by the veteran. 

 
 
 
My Group’s Inquiries: the screen default after you log in 
When you log in, you automatically go to your profile default screen from which you initiate all 
activities. In all cases, your profile default screen should be My Group’s Inquiries.  This workspace 
will show all the inquiries that belong to your mailgroup. 
 

 The My Group’s Inquiries Screen: 

 
 
 
 
 
 
 
Menu Bar

 
 
 

 

Navigation Pane:  Left Side Column 
 
Items listed in the navigation pane will depend upon your level of access to the IRIS. All levels of 
access to the IRIS should show My Group’s Inquiries as the default.  The other items shown in the 
Inquiry Items section are other views; do not use them unless instructed to do so.   

The default screen that is opened after login should be, in all cases, My Group’s 
Inquiries.  My Group’s Inquiries is the view that displays the open inquiries in 
your routing destination that need action.  If any other choice is selected, you will 

need to click on My Group’s Inquiries to see your IRIS inquiries. 

Tabs will display across the top of the screen (or on the 
bottom if you choose to change the location via the 
Personal Settings)  as you open different screens. The 

first tab to display should be My Group’s Inquiries. 

This bar at the top of the screen is called the Menu Bar.  The 
most likely option that will be used is Preferences, which is 
used to select the settings to receive alerts and to change 
your password.  Only those settings that apply to your level of 
access will be usable 

Buttons at the bottom of the navigation pane provide access to other features, depending 
upon your level of access.  In this instance, you can click on Analytics/Reports or on 

Answers (FAQs). The default should be Inquiries. 

My Group’s Inquiries should show at the top.  

The vertical column on the left of the screen is 
called the NAVIGATION PANE.  What is 
displayed in this column is dependent on your 
level of access to the system. 

This bar at the top of the screen is called the Menu Bar.  The 
default tab is Home.  The tabs for Display and Page Setup 
are available only to those users with Reports access; 
otherwise they are grayed out.  

This is the RightNow icon button; use this to change your Personal Settings. 
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Recent Items comes next; this section shows the ten items you accessed most recently. When you 
move on to something else, the new item will appear at the top and the oldest will be removed from 
the bottom of the list. 
Quick Search comes next; this section allows you to search for a particular inquiry or a particular 
contact. 
Buttons displayed at the bottom of the navigation pane depend on your level of access.  In this 
example, the IRIS user has access to Inquiries, Analytics/Reports and Answers (FAQs). 

 
  
 
Buttons at the bottom of the Navigation Pane allow access to other features/functions for which 
you have access permission; everyone has the button for Answers/FAQs.  

 
 

Navigating to another function 
Selecting another item may change other items on the navigation pane. For example, if you want to 
navigate to Analytics/Reports, click on that horizontal button on the bottom left and different choices 
will appear at the top of the column.   

 
  

All levels of access to the IRIS, except for Reports Only access 
should show My Group’s Inquiries as the default.  Other items 
listed will depend on your level of access. 

Everyone with access to inquiries has the Quick Search 
capability to find an inquiry or a, contact.  Use the dropdown 
arrow to select Contacts Quick Search or Inquiry Search.  

Items shown at the bottom are the horizontal buttons for the 
features/capabilities that are available to your user profile. When you 
select a feature using a button on the bottom of the nav pane, your 
choices for that selection will be displayed at the top of the navigation 
pane.  See next screen shot. 

 

1. If you have access to the Reports function, click 

on Analytics/Reports button. 

2.  Explorers section will appear at the top of the column.  Click on 

Reports Explorer to get to the Reports capability.  

The buttons on the bottom depend on your level of access.  Everyone has 
access to the Answers/FAQs. 
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To return to your open inquiries screen, click on the Inquiries button on the bottom of the 
navigation pane and then select My Group’s Inquiries (default) if it is not already selected. 

 
 
 

Quick Search Options: Search by Contact & SSN or by Inquiry Number 
 
When Contact & SSN Quick Search is chosen, you can do a search using Last Name, First Name, 
Middle Initial, E-mail Address, Claim Number, Service Number and/or SSN. You can search 
using any of those fields alone or in combination.  You can also use a wildcard search, which is the 
percent sign % replacing part of the search string (for example, %223 in the claim number field would 
look for all claim numbers ending in 223).  See additional information in the Wildcard Search section 
of this manual. 

 
 
When Inquiry Search is chosen as the search method, the search display will change and the 
Inquiry # field will show.  You MUST enter the entire inquiry number or use the wildcard percent sign 
(%)  to search for a partial string (for example, 101005% would look for all inquiries that came in on 
October 5

th
, 2010). See additional information in the Wildcard Search section of this manual. 

 
 
Search Results will display in the content pane.  In this example, a search was conducted using a 
specific  inquiry number. The inquiry opened in the content pane. 

 

1. To return to your open inquiries screen, 
click on the Inquiries button on the bottom 
of the navigation pane 

2.  Select My Group’s Inquiries (default) 
if it is not already selected. 
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My Group’s Inquiries Home Console Workspace Tabs and Buttons 
 
Upper Screen Tabs: Tabs on the upper screen are Home, Report, Display and Data: 

 Home tab is the default and is the tab used by everyone.  This is the tab that is the inquiry 
console screen.  It should always display the My Group’s Inquiries console screen. 

 Report tab will only be used by IRIS staff with Analytics/Reports capability 
Do not use the Display or Data tabs. 

 The Ribbon: The horizontal row of buttons is known as the ribbon; the buttons are for 
functions that IRIS users will utilize all the time and include New, Open, Create Duplicate, 
Print, Assign, Search, Refresh and Reset. 

 

 
 
 

The Ribbon for the Home tab 

 
 
 
Top (or Bottom) Screen Tabs: tabs will appear as you open inquiries, screens, or contact 

records.  The default is to open across the top; you can change to the bottom if you choose in the 
Personal Settings options. 

 
Tabs, similar to those on an Excel spreadsheet, will appear across the top as you navigate through 
the application. As you open more items, more tabs will appear across the top, when you open an 
inquiry, a tab with that specific inquiry number will appear at the top.  

 
The tab on the far left should be My Group’s Inquiries. Clicking on this tab will take you back to the 
initial Inquiry console screen.  
 
 

 
 
Closing the Screen Tabs 

 
To close a tab, right click on it and open the dropdown list to: close that specific tab, close all other 
tabs but the selected tab, or close all tabs. 

Home tab is the default and is the tab used by everyone.  This is the tab that 
is the inquiry console screen. 

Display and Page Setup tabs are available 
for people with reports access and are used 
to adjust reports printouts. 

Tabs, similar to those on an Excel spreadsheet, will appear across the top as you 
navigate through the application. The tab on the far left should be My Group’s 

Inquiries. Clicking on this tab will take you back to the initial Inquiry console screen. 

When you open an inquiry, a tab with the inquiry number will 
appear at the top.   As you open more items, more tabs will 
appear across the top. 

To close a tab, right click on it and 
open the dropdown list to close it, 
close all tabs but this one, or all tabs. 

The horizontal row of the 
buttons across the top of 
your screen is known as 
the ribbon. 
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Ribbon Buttons and Their Functions 
 
The ribbon runs across the top of the display on the Home tab and has buttons that permit particular 
activities to occur when using the My Group’s Inquiries screen. Each button is discussed below. 
 

 
 
 
 
Open Button:  Use to Open an inquiry or the Contact Record that belongs to the 
highlighted inquiry in your inquiries list 
 
Double click on the Open button to open the inquiry highlighted in your open inquiry list; the top item 
is the default highlighted inquiry.  You can also double click on the line item itself to open the 
inquiry.    
 
Open Button: To open a contact record, select contact record from the button’s dropdown and 
enter the contact information to search for and retrieve the contact record. 

 
 
 
New Button:  Use to Create a New Inquiry

 
.  
Print Button 

  
The Print function will print the information currently saved.  You first see a print preview of the inquiry 
and must click on File>Print to actually get a paper copy. Paper copies may not display all the PII 
fields if those fields were not completed. For example, if no Service Number was entered in the 
Service Number field, that field will not display on the print out at all. 
 

 

Double click on the New button to enter a new inquiry.  You 
do not have to use the dropdown box.  

This part of the screen is known as the Ribbon and 
contains the buttons used to perform numerous 
functions.   

The Open button is used to open up the highlighted inquiry in your listings. The 
default highlight is the first item in your listings unless you click one time on 
another listing.  You can double click on the Open button, or select inquiry from 
the dropdown or just click on the line iten. 

Home tab is default.  This tab contains your workspace. 

The Contact selection button is used to retrieve the contact record 
that belongs to the highlighted inquiry. 

The Print button allows you to print the highlighted inquiry or 
the contact record associated with the highlighted inquiry.   

The Print button opens a print preview.  You must click on 
File>Print to obtain a paper copy.  
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Create Duplicate Button 

 
 
Create Duplicate button creates a duplicate copy of an existing inquiry that is highlighted in 

the inquiry listings, giving the duplicate a new number and allowing additional input and/or allowing 
that duplicate to be routed to another mailgroup for response. This function is used when a single 
inquiry concerns multiple issues and more than one mailgroup is needed to resolve each issue. See 
manual section describing this process and when it is used. Note: Do NOT create duplicate contact 
records. If you do by mistake, contact the VA IRIS System Admins to correct it immediately.  
 
 

Assign Button 

 
 
Assign button is used to assign/reassign a highlighted but not opened inquiry. Click on the Assign 
button and then select the correct routing destination from the dropdown list of all IRIS mail groups. 
Also pick a subset of that mailgroup. The mailgroups appear in alphabetical order, with all NCA 
groups with ―NCA‖, VA groups starting with ―VA‖, VBA with ―VBA‖, VHA with ―VHA‖, etc.   To 
reassign, select the correct mailgroup and its subset and then Save to move it.  Find the subset by 
clicking on the + sign to the left of the mailgroup name to open up the subsets.  Note: You may need 
to open the inquiry to add a Private Note before you reassign it to provide any necessary information 
to the receiving group if the receiving group needs additional information from you. 

 
Warnings:  
1.  Do NOT reassign inquiries to Call Center mail groups. They do not receive inquires for response; 
their traffic is outbound only for assignment to mail groups who are designated as responder groups.  
2.  Do NOT ever re-assign an inquiry in Solved status. 
If you are not sure what group has jurisdiction (issue, geographic location, etc., please utilize the IRIS 
Participants Dropdown Listings document.  When an inquiry is open, click on the IRISInfo Website 
Help tab; it will link directly to the instruction guides. Mailgroups are listed in alphabetic order, service 
area information, etc.  You can easily access all IRIS background documents by using the IRISInfo 
tab on the console screen when you open an inquiry.  When you open the document, use Control+F 
function and put your cursor somewhere in the text of the document (not a call out box), and enter 
your search term and find it.  
 

Delete Button:  NOT available to the field.  

 
 
Delete button is not available to the field.  Contacts and inquiries can only be deleted by the IRIS 
System Administrators. 

Create Duplicate Button 

To assign/reassign a inquiry highlighted in your inquiry listings, click on the 
Assign button and then select the correct routing destination and a subset of that 
location from the dropdown list of all IRIS mail groups.  See notes and warnings in 
section below. 

Do NOT ASSIGN CONTACT records. 

Click on the + sign next to the desired 
mailgroup and pick a subset as well. 
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DO NOT USE:   
 
Search button: search using selectable parameters.   Search allows you to search the IRIS 
database by using the same or more search parameters than the Quick Search function which only 
allows searches using contact name or inquiry number.  Full search allows you to search using claim 
numbers, phone numbers, etc. You can search only your own mailgroup’s items, selected mailgroups’ 
items, or the whole system. 
 

 
 

 
 

 
 

 
 
 

 
 
 
Wildcard Searches: Using % and * Symbols 

% Search:  using either the full search function   or 

the Quick Search function  
                                                               
You can search for an inquiry with only a partial name, partial claim number, partial summary string, 
etc. by using the percent (%) character in the search field in either the main search function or in the 
Quick Search function. Once you have clicked on the Search button, do the following: The steps are: 

1. Set the parameters for status codes that you want to search (Solved only, All Status Codes, 
etc.) 

2. Set your parameters for the mailgroup(s) that you want to search.  Logged In refers to the 
mailgroup that you are logged into. 

Search the IRIS database, using more parameters than Quick Search, 
such as claim number, inquirer last name, veteran last name, phone 
number to find inquiries.  

You can search using any one of the fillable fields on the Search 
window:  
Contact Last Name, Contact First Name, Phone Number 
Email Address, Claim Number, Inquiry Number 

Once you have filled in 
the search parameter, 

click Search 

From Groups box, you can select what 
mailgroups to search. Logged In refers to 
your own mailgroup.  

Search results, if any, will manifest on your 
screen as line items.  

Click the Reset button to restore 
your original screen. 

 If there are no results, there will be a message 
saying ―There are no items to show in this view.‖ 
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3. Select the search field you want to use, fill the search field with the search string preceded by 
the % sign. For example, if you want to find all the inquiries with the word ―test‖, you would 
enter %test in the Summary field or you can search using the % at the end of the string. For 
example, you could enter in the Last Name field Smith% so that you will get a return of every 
contact record where the last name begins with Smith. See screen shots below.  

4. Click Search. 
 

To find all the inquiries in your mailgroup with the word ―test‖ in the subject line using the full search 
function, you would do this: 

 

 
 
 
Search results for this example come back as line items on a new screen.  All results are inquiries in 
this mail group that have the word ―test‖ in them.  

 
 
 
To find all the inquiries in your mailgroup whose last name begins with Nord using the Quick Search 
function,  you would enter Nord%: 
 

 

1. Set your 
parameters 
for status 
codes you 
want to 
search. 

3. Enter % first followed by the data you’re looking for in 
the search boxes. In this case, you are looking for the 
word ―test‖ in the inquiry threads of all inquiries 
assigned to your mailgroup.  

Search results for this example come 
back as line items on a new screen.  All 
results are inquiries in this mail group 
that have the word ―test‖ in them.  

2. Set your parameters for the mailgroup(s) that 
you want to search.  Logged In refers to the 
mailgroup that you are logged into. 

4.  Click Search. 
 

To find all the inquiries in your mailgroup 
whose last name begins with Nord, you 
would enter Nord% 
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To find all the inquiries that your mailgroup received on a given date, you would enter the date into 
the inquiry number field in Quick Search, i.e. 101201% to find everything in the system dated October 
11, 2010. 
 

 
 
* Search (Star/Asterisk) Search for Phone Numbers 
You can conduct a search for an inquiry or contact record using phone numbers by using partial 
number strings with the star/asterisk symbol rather than the entire phone number. 
If you want to find a record using the last four digits of a phone number, you can enter *xxxx.. 
You can search using area code and or prefix only using xxx* or xxxxxx*. 

 
Any results will be listed as line items on the search return. 
 

Refresh button 
When you are done with the Search function, Refresh will update your screen with any new inquiries 
that have come in since the home screen was last viewed. 
 

 
 
Reset button 
Reset allows you to return to the Search default screen after you have completed a search for which 
you changed the default parameters.   

. 

 
 

 
Reports buttons on the Right End of the Ribbon 

Only IRIS users with Reports access will have access to the buttons on the right end of the 
ribbon.  All of these buttons are material to pulling reports and arranging/utilizing the information 
found on the reports results.   The buttons are: Find, Auto Filter, Sort, Rollups, Slice, Export, 
Default Settings, and Definition. See screenshot. 

 

 

Refresh will update your screen with any new inquiries that 
have come in since the screen was opened. 

In this example, the search is 
for a phone number that ends 
in 9999 using *9999 in the 
Contact Phone Number field. 

Reset allows you to return to the Search default 
after you have completed a search for which you 
changed the default parameters. 

To find all the inquiries in your mailgroup 
on a given date, you would enter the date 
followed by % (xxxxxx%). 

Reports buttons are on 
the right end of the 
ribbon.  
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Find    

You can search for specific text, numeric values, or special characters in the content displayed in a 
report using the Find feature. Cells in the report page currently being viewed that contain the values 
you searched for are highlighted. Content on other pages or drill-down levels in the report must be 
searched separately. 

To Find content in reports  
1  .  Open the report you in which you wish to Find content. 
2  .  Click the Home tab. 
3  .  Click the Find button on the ribbon to open the Find window. 

 

4.  Type the search value you want to Find in the report in the Find Text field. To highlight cells in the 
report only if the content matches the exact case you use in the search value, select the Match Case 
check box. 
5.  Click the Find Next button to close the Find window and highlight the first cell in the report. 
6.  To highlight cells in the report only if the cell content exactly matches the search value you enter in 
the Find Text field, select the Match Entire Cell Contents check box. 

 

7.  Click the Find Next button to close the Find window and highlight the first cell in the report that 
matches the search value you entered OR Click the Find button to close the window and highlight all 
the cells in the report that match the search value that you entered. 
8.   To find the next instance of the search value without opening the Find window, click the Find 
button on the ribbon’s Home tab. 
9.  To clear the search value you entered without opening the Find window, click the Clear button on 
the ribbon’s Home tab. 
 

Auto Filter  
This button allows access to filter on any column in the report that you have pulled.  Once this is 
enabled, click the down arrow in any column heading. 
 
Other Report Buttons: 
Sort, Rollups, Slice, Export, Default Settings, Definition buttons 

 
 
Sort is used to select what columns to sort by and the sort method. 
Rollups   This button allows you to define rollups to group and organize the rows in the report.  
Rollups appear as expandable/collapsible sections in the report where the records in each section are 
grouped by the rolled-up column.   You can roll up the report by one or more report columns. Right-
click a column and select Edit Calculations from each grouping level.  A window opens where you 
can edit section calculations. 
Slice   This button allows you to slice the report group and organize the data.  You can group the 
data set in buckets based on your slice definition.  You can view the entire data set or each slice 
individually. Each slice may be displayed as a tree or as links at the top of the report. Multiple 
columns can be used as slice criteria to further separate data in each bucket. 
Export   This button allows you to report data in an alternate file format and provides a snapshot of 
the current data set in the selected file format.  The formats allow easy use for analysis or viewing in 
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other commonly used applications. Several of the formats preserve the current settings for the 
generated data file. You can also export using a delimited format. NOTE: To export a report to 
Excel, you must be running Excel 2003 or later versions. The export functionality is designed 
to utilize XML parsing that is available in Excel 2003.  No earlier Excel versions are supported. 
Default Settings   This button allows you to save personalized display and data settings for later use 
or remove them and restore to the default. 
Definition:  This button allows you to view or export the definition of the report. 
Choose View to view detailed descriptions of all the tables, filters, variables, columns and levels 
associated with the report.  Choose Export to export the report definition to an xml file.  
 
 
 

The Inquiry Console/My Group’s Inquiries Home Screen (default screen) 
 
 
 
 

 
 
 

Left Navigation Pane 

 
 
 

The Content Pane is the section of the home 

screen that lists a mailgroup’s open inquiries. It is set 
up to display the following columns from left to right: 
Inquiry #, Subject, Status, Date Created, Date Last 
Updated, Initial Response Due, Inquirer Last 
Name, and Group.   
 

 

RightNow icon: Gets you to 
Personal Settings. 

Upper Tabs:  Home tab is default.  Display and Page Setup tabs 
are for use when performing Reports/Analytics functions if you 
have Reports permission. 

Ribbon area:  Specific Buttons 
are enabled for field use 
according to Profile permissions.  

Tabs open up across 
the top as you work on 
different things.  You 
can move tabs to open 
across the bottom if 
desired by changing 
your personal settings. 

This area is the Navigation Pane.  See next screenshot 
for explanation. 

These are horizontal buttons that let you change to the 
Analytics/Reports function or the Answers/FAQs function.   Buttons 
displayed depend on your user profile.  NOTE: If you select a different 
horizontal button, you must move up to the top of the Navigation Pane 
to adjust the Inquiry Items to be compatible with the function choice.   

Default is My Group’s Inquiries.  If you choose to use another 
function using a horizontal button at the bottom of this pane, you will 
have pick something else from the top. See screenshots below. 

Recent Items displays the last 10 items you worked on, with the most recent on top. 

Quick Search using either Contact Info and/or SSN or select 
Inquiry Quick Search to search by specific inquiry number or 
inquiry wildcard string 

.  
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To Navigate to another function:  
If you pick a button other than Inquiries on the bottom of the left navigation pane, you will 
need to also pick a corresponding item from the top of the nav pane.  
 

 
 
Column Sorting:  By clicking on a column header, you can reverse the order of the inquiry 

numbers, alphabetize the inquirer name column, etc.  

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
Scroll to next page of inquiry listings 
If you have more inquiries than can be displayed on one screen, you can scroll through additional 
display screens to see the others.  Click on the page scroll numbers at the top of the screen right 
above the inquiry listings.  The page scroll capability will only appear if there are multiple pages. 
 

 

 
 
 
 

Subject 
displays 
the first 50 
characters 
of the 
inquiry 

content. 

Inquiry 
number; 
year, 
month, day 
and 
assigned 
number 
based on 
order of 
arrival in 
the system 
on any 
given day. 

Group 
displays 
the mail 
group to 
which the 
inquiry is 
assigned. 

Date 
Created 
displays 
the date 
and time 
the inquiry 
was first 
submitted. 

Initial 
Response 
Due displays 
the initial due 
date, based 
on the 5 
business day 
response 
rule. When 
more than 5 
business 
days old and 
no response 
sent, the line 
item turns 
red. 

Status 
displays one 
of multiple 
status codes.  
All status 
codes display 
on this 
screen, 
except for 
Solved 
which appear 
on another 
screen. 

Inquirer 
Last 

Name 

Date  
Last 
Updated 
displays 
the date 
and time 
the 
inquiry 
was 
updated. 

Scroll to following 
pages. 

Click on Column header to reverse the inquiry numbers, sort by date, inquirer’s name, etc. 

1.  Select 
Analytics/Reports, on the 
bottom of the nav pane,  

2.  Select Reports 
Explorer, on the top of the 
nav pane,  
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Responding to Inquiries 
 
Navigation and Basics 
 
Opening an Inquiry: Double click on the line item or click on the open button to open the 

highlighted inquiry.  NOTE: The first inquiry listed is the default for the highlight.  The highlight is very 
pale.  If you single click on another listing and highlight it, then click the Open button to open that one. 

 
 

 
 
When you open an inquiry, it opens up and occupies the entire screen to the right of navigation panel. 
A new tab opens on the bottom of the screen that shows the inquiry number. 

 
 
 
 
Close an inquiry without taking any action, right click on the tab at the top and select 
Close. 

 
 
 
 
   

To open an inquiry, you can:  

1) Double-click on the line item OR 

2) Click on the Open button and the 

first listed inquiry will open. 

Note that when you open an inquiry, a new tab 
appears at the top of the screen that is labeled with 
the inquiry number. If you wish to close the inquiry 
without taking any action, right click on the tab to 

close it.  See next screenshot. 

To close an 
inquiry without 
changing 
anything, right 
click on tab with 
inquiry number 
and choose 
close. 
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Save/Save and Close buttons 
 
Save button will save all your work but leave the inquiry open on your screen.  This is useful if 
you want to print the inquiry with everything that you have done and Save since opening the inquiry or 
work on it for some other reason. 
Save and Close button:  To close an inquiry after taking an action, click on Save and Close 
button which saves everything and also closes the inquiry.  
 

 
           

 
Open Inquiry Screen 

 
 
Upper Screen of open inquiry: Upper screen contains two sections: Inquirer Details on the left 

and Inquiry Details on the right.  Note that the Personal Identifying Information (PII) that fills the 
fields on the upper screen contain information found in the Contact Record for this inquirer.  If 
information is edited on the upper screen or in the Contacts tab, the changes will be made 
automatically in both places. 
 

 
 
 

To close an inquiry after taking an action, 
click on Save and Close.  

The Contact Details provides information 
about the inquirer such as name and address.  

Upper screen of open inquiry 
contains PII contact record 
information (name, address, phone, 
email address if any, etc.) and 
information relevant specifically to 
the inquiry information (assigned to 
which mailgroup, topic/subtopic, 
requested method of response, etc. 

Lower screen of open inquiry displays the 
message, any message updates, private 
notes attached to the inquiry, etc. 

The Inquiry Details provides information  about the 
inquiry itself such as type of inquiry, topic/subtopic, etc..  

Tab section that accesses additional information. 
Tabs are Message, Contacts, Internal 
Attachments, Info Submitted via Web Entry 

Form, Audit Log, IRISInfo Website Help. 

To save your work and leave the 
inquiry open on your screen, click 
on Save. 
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Inquirer Details Fields in the left section: 

Form of Address: Mr, Mrs, Ms, etc. 
First Name of Inquirer 
Middle Initial of Inquirer 
Last Name of Inquirer 
Address displays part of the address data which has been combined in one field. To see all of the 
address data, you must click on the Edit link in the Address field for the box to open up and show all 
of the combined address data that has been entered. NOTE: If no address data has been entered, 
you must enter something in the address box to assign/reassign or otherwise deal with an inquiry 
and no address data has been supplied by the inquirer, you can get past this field by selecting 
only country and/or state and country as you are able to determine from the rest of the content. 
Not all fields in the address box need to be completed. 

 
 

 
 

Inquiry Details in the right section: 
Reference Number: This is the inquiry number which is the year/month/day hyphen and six digit 
number assigned by the system in order of receipt. 
Vet is Inquirer on this Inquiry?  Yes or No 
Type:  Type of inquiry as selected by the inquirer (codes may be added or removed by IRIS System 
Admins): The types visible to the public are:  
Question 
Status of Claim 
Service Complaint (lack of courtesy or service received from VA) 
Compliment, Suggestion 
Status of Appeal at a Local VA Office 
Status of Appeal at BVA in Washington DC 
Combat Call Initiative Inquiry 
 
There are more types available to VA users; those not visible to the public were created for and are 
used almost exclusively by VBA staff. The inclusive list is:  

 

 

The Address field displays part of the address 
data that has been entered, if any. Click on Edit 
to see all the address data. 
 
 
date in this field. 

The see all of the address data that has been 
entered, click on the Edit link in the Address 
field. 
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Status:  Gives the status of an inquiry; most often will be Unresolved. NOTE: If the inquirer updates 
his inquiry, the system will automatically set the Status field to Additional Info Provided. Status 
codes are: 

   

     
Status Code Definitions in order of appearance:  

 Additional Info Requested—If a responder needs more information from the inquirer to be 
able to respond, s/he may wish to manually put the inquiry into this status until the necessary 
information is obtained, at which time the response can be sent and the status manually set to 
Solved.   This status code leaves the inquiry on the open inquiry screen and does NOT move it to 
another console.  

 Additional Info Provided—This status is set automatically when an inquirer updates an 
existing inquiry. Inquirers may update the same inquiry for 31 days after the last action taken on that 
inquiry by the inquirer OR by VA.  If the inquirer continues to update the same inquiry, the life cycle of 
the inquiry can be considerably prolonged. If more than 32 days transpire from the last action, the 
veteran must submit a new inquiry. Note: this does not change its status within VA.  If 32 days have 
passed without a response or other action from VA, the inquiry stays open until there is a disposition 
by VA.   Inquiries do not expire. 

 Solved— This status is set automatically when you send a response and save the inquiry; it 
may be overridden manually if you reset it to another status code prior to Save. (NOTE: if the inquirer 
did not provide an e-mail address, the IRIS cannot send an electronic response and an alternate 
means must be used.  If an alternate method is used, a Private Note should be entered and the 
status manually set to Solved.)  Solved inquiries are moved to another console to which you must 
navigate using the Search feature. Once in Solved status for 6 months with no activity of any kind, 
inquiries are archived and no longer are displayed on the Solved console.  After they have been in 
Solved status for 19 months with no activity of any kind, they are purged from the system. DO NOT 
EVER REASSIGN AN INQUIRY IN SOLVED STATUS; if you do, the receiving location will never 
know they have it because Solved inquiries go into another basket and are never seen unless 
searched for. 

 Pending File Review—Used by VBA when a claims file needs to be reviewed prior to 
responding. 

 Need Info from Non-IRIS User—Used when a VA employee/organization not in the IRIS  
must be consulted before a response can be sent. 

 Solved Duplicate—Set manually when duplicates are received.  Duplicates are created 
when inquirers repeatedly click the submit button at the bottom of the IRIS customer entry form 
despite being told to click the button only one time.  Every time the button is clicked, a duplicate with 
a new number is generated.  If a responder receives duplicate inquiries, s/he must respond to one of 
them and then set the status of the duplicates to Solved Duplicate in the status field. 

 Reviewed—Set manually by a supervisor or other designated employee who is required to 
review a response before it can be sent.   Changing to this status code informs the responder that 
s/he can now send the response. 

 Assigned/Unresolved—Set manually in VBA call centers when inquiries are assigned to 
designated staff and still require responses. 

 Pending Investigation—Set manually when a response cannot be sent until an official 
determination can be made that a response can be sent to the inquirer (i.e., an entity responsible for 
more than one veteran, such as a custodian, whose status must be verified before information can be 
released.) 

 Waiting for Contact—Responder is making attempts to contact by phone to resolve. 
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 Awaiting Guidance—Set manually by call centers when supervisory review is necessary 
before response can be sent. 
Daytime Phone: This field is for the daytime phone number.   
Subject: Repeats first fifty characters of the beginning of the inquiry message if submitted through 
the VA Web site.  If the inquiry is created from inside VA, the subject line may not match the first fifty 
characters of the inquiry. 
Assigned: The Assigned dropdown box shows the mailgroup to which the inquiry is assigned and is 
also the place where you can reassign an inquiry to another mailgroup.   
Topic/Subtopic:  Lists the Topics and subtopics selected by the inquirer on the IRIS customer entry 
form.  (List is subject to change.) To see the subtopics, open the Topic by clicking on its + sign to the 
left of the topic name. Topics are: 

 

 
 
Type of Response: The inquirer selects the method for response: email, US Mail or telephone.  If 
s/he wants a response other than email, the email field will most often be blank. 
Email:  Email address of the inquirer.  If there is no email address, you cannot send an electronic 
response.  The inquirer will have requested another Type of Response. NOTE:  If more than one 
individual is referenced on an inquiry and persons listed other than the inquirer also have email 
addresses, each of them will receive the responses. 
 

Inquiry Tab Section:   
The opened inquiry tab section displays tabs for Messages (default), Contacts, Internal 
Attachments (attachments added for internal use only), Info Submitted via Web Entry Form, Audit 
Log, IRISInfo Website Help, The tabs available to everyone are described below. Note: Additional 
tabs may be added for specific groups or purposes. 
 

 
 
                                                                   Inquiry tab section 
 
Messages Tab is the automatic default when you open in inquiry.  This displays the message from 
the inquirer and also provides access to additional features needed when responding to an inquiry.  It 
also displays on the blue strip how the inquiry entered the system, either by the inquirer coming 
through the web on VA’s Internet website, or if it was entered by a VA employee on behalf of the 
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inquirer, which is almost always by phone contact via the VA call centers.  Other methods of contact 
are selectable by using the dropdown capability. 

 
 
 

 
 
 
 
Contacts Tab provides information using subtabs relevant to the contact record (personal) 
information.  PII is initially recorded and edited using the Contacts tabs and forms; the fields on the 
upper screen of the inquiry were auto-filled based on the information from the Contacts function.   
After the information is initially recorded using the Contacts function, fields that appear on the 
inquiry upper screen can be altered and will change the data in the corresponding contact 
record. 
 

The Contacts subtab displays the ―official record‖ of the full name, email address, and phone 

numbers, if provided during the customer entry process.  If the inquirer is the veteran, and/or is 
inquiring only for him/herself, there will be a single line item with inquirer data and the Contacts 
subtab will show (1) after its label. This means that this inquiry only concerns one person. The radio 
button that is checked means this person is the inquirer.  
 

 
 
If the inquirer is not the veteran but is asking for/about a veteran or represents the dependent of a 
veteran and supplies information regarding that other person, the Contacts tab label will display (2) or 
(3) since the inquiry involves two or three persons: the inquirer and the veteran OR the representative 
(inquirer), the veteran and the dependent.  That second (and third if applicable) person’s name will 
also display. The person whose data has a checked radio button is the inquirer. The unchecked 
radio button provides information about the veteran who is not the inquirer. DO NOT CHANGE THE 
RADIO BUTTON SETTINGS. 
 
 

 
To access more information about the person(s) listed on the Contacts subtab, double-click on the 
person’s name or on the open link to the far right of the person’s name on the same item line.  Do 
NOT click on the radio buttons. 
 

Default is the 
Messages tab 

Message content is displayed here. 

The Contacts subtab shows the name of the inquirer and indicates 
that the inquirer is the only person/contact involved with this inquiry; 
note the (1) displayed on the subtab label.  The checked radio 
button means that the person whose name is shown is the inquirer. 

The Contacts subtab shows the name of the inquirer, indicated by the checked 
radio button and also shows the name of the veteran. Since this inquiry pertains 
to two persons, the (2) is displayed on the subtab label.  The checked radio 
button means that the person whose name is shown is the inquirer; the 
unchecked radio button belongs to the veteran who is other than the veteran. 

The blue strip will indicate if the inquiry came through 
the VA website or if the inquiry was input by a VA 
IRIS user on behalf of the inquirer, which is almost 
always by phone. If other than Web Form, the default 
is phone, but this can be changed by using the 
dropdown box. 

 
 

  
 

 

Dropdown arrow 
to select method 
of receipt of 
inquiry. Default is 
Phone. 
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E-Mail Address Data and No E-Mail Address Data 
 
Inquiry has an e-mail address  
The e-mail address, if any, is shown on the upper screen and also on the Contact tab and; not all 
inquirers have or supply their own e-mail, so this field may be blank.  If the inquirer has no email 
address, you cannot send an IRIS response electronically. 
 
You must check the Type of Response field to determine by what means the inquirer wants VA to 
respond, which will be email, telephone or US Mail. 

 
 
 
NOTE:  if more than one person/contact is cited on a specific inquiry and both parties have 
email addresses and an email response is requested, BOTH persons will get the response. 
 
No E-Mail Address on Upper Screen or Contacts Tabs:  The IRIS cannot respond via e-mail 
without an e-mail address. The absence of an e-mail address is an indicator that the inquirer 
requested a response via telephone or surface mail rather than by email.  The preferred method for 
response is shown in the upper inquiry section in the Type of Response field. 
 

 
 
 
 
 
Edit an E-Mail Address or other personal information 
If you need to edit an existing email address or any other information pertaining to an inquirer, you 
can 1) edit from the fields in the upper screen or 2) you can click on the person’s name on the 
Contacts tabs to access the personal information and edit any of the information recorded there. 
 
If you need to edit the information about the veteran or other party mentioned in the inquiry but who 
is NOT the inquirer, you must use the Contacts subtabs by clicking on that person’s name and then 
editing his/her information from there.    
 

1. To open more information about the person(s) 
listed on the Contacts subtab, double-click on the 
person’s name OR 

2. Click on the open link to the 
far right of the person’s name on 
the same item line 

On upper screen, the E-mail 
address for inquirer, if any, 
will display here. 

The type of response requested is 
displayed here. The choices are: 

 

On the Contacts tabs, the E-mail 
address for inquirer, if any, will also 
display here. 
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Duplicate E-Mail Address Error: 
If you enter an email address for a contact and then click Save, but get a Duplicate E-Mail Address 
message, you must reconcile the problem and determine if the same email address is in use by 
another person, or if you are duplicating an existing contact record, or determine there is another 
issue concerning the email address.   You may need to delete an email address to resolve the 
problem. 

 
Inquiry History Subtabs under Contacts Tab 
 

Inquiry History for Inquirer tab 
This tab will list all inquiries still in the system (closed inquiries are purged at 24 months) that came 
from this inquirer. The tab label shows in parenthesis the number of inquiries in the system that have 
yet to be purged due to age.  All of the inquiries from this inquirer will be listed; you can click on any 
of them to open them up..  

 
 
In the following example, the inquirer has a history of inquiries. The tab shows 40 prior inquiries from 
this inquirer.  You an open and/or print any of the others.  This list is long enough that a scroll bar 
appears at the right so that you can scroll through them. 

 
 
Inquiry History Secondary Contact tab 
The secondary contact pertains to the other person(s) involved with this inquiry.   If the inquirer (the 
primary) is asking about a veteran (the secondary party), this tab will display information about that 
other person. If the inquirer represents the dependent of a veteran, there will be more than one 
secondary contact listed.  There will be an entry for the dependent and another for the veteran.   
 
In this example, there is no secondary contact information on that tab because the inquirer was the 
veteran or did not provide any information on a veteran other than himself/herself. 

I  

To edit an email address or to edit any personal data 
fields, click on the person’s name to open the contact 
record screens for editing.  Click OK when changes are 
made to return to the inquiry screen. When you Save or 

Save and Close, those changes will be recorded. 

Person’s name will appear at the top of the Contact Record so 
that you know whose contact record is being edited. 

The Inquiry History in this example shows 1 
inquiry from this inquirer, which is the inquiry 
that you have opened on your screen. 

Inquiry History for Inquirer in this example 
shows 40 inquiries from this inquirer 

You can open and/or print any of the other inquires by clicking on the link on the right 
end of the line item or clicking on the line item to open the inquiry. 

When there are more inquiries that can display on the screen at 
the same time, a scrollbar appears at the right. 
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In this example, an inquiry was submitted on behalf of a veteran (the secondary contact) who is other 
than the inquirer, but we have no other inquiries from or pertaining to this veteran in the system other 
than the one we are working on, so only one item is shown. 

 
 
 
Inquiry History on a Contact Record (Primary and Secondary) 
 
On a contact record, the inquiry history will display all the inquiries submitted by this individual 
and/or will show any inquiries on which this person was cited as a secondary contact.  If the latter, it 
means that someone sent in an inquiry about or on behalf of this person.  If a third party is involved, a 
second item will display in the Secondary history. For example, if the representative of a dependent of 
a veteran submitted an inquiry, the primary contact history will show inquiries submitted by the 
representative and the secondary history will have inquiries cross-referenced for the veteran and for 
the dependent.  See screenshot below. 
 

 
 
 
Adding Attachments; attach to response or for internal use 
 
There are two different functions for adding attachments to an inquiry: 
1.  To send an attachment to the veteran, use a feature that appears on the left side of the response 
box. See instruction a below. 
2. To attach a document for internal use only use the Internal Attachments tab. See Internal 
Attachments section b below. 
 

a. Attach a File/Document to A Response (Attach and Send to the Inquirer with 
Response). 

To attach a document to a response, you must use the response box in the Message tab. Open 
the inquiry and click on Add on the Message tab.  Select Response and type in response. 

 

 

On the Message tab, click 

Add and then Response. 

If this contact submitted an inquiry on his/her own behalf, the 
inquiries would be listed here since the veteran is the primary 
individual. 

If this contact had an inquiry submitted that cited him/her as a 
secondary party, the inquiries would be listed here. 
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When the response box is open, a dotted blue vertical bar appears on the left border of the box with 
a marked space between two arrows.  Type in your response, and click on the dotted blue bar to 
open the attachment box. 
 

 
 
 
 

 
 
When the attachment box opens up, you will find your response typed into the response field 
of the attachments box and can still edit it inside this field.  

 
 
Do not use the cc or bcc buttons because encryption is not available using these buttons. 

 
 
If you decide NOT to send an attachment, click on the vertical dotted bar to close to the 
Attachment box 

.  
 
If you decide to continue with the attachments, click on Add Files and find the attachments. 

Response field is open 

Note that when Response is open, this dotted blue vertical 

bar appears on the left border of the response box. 

Type response in response field. 

To add an attachment that will be sent to the 
inquirer with a response, click between the 
arrows on the blue side bar. 

Do Not Use the cc or bcc buttons. 

Click on Attach  

If you decide NOT to send an attachment, 
click on the vertical dotted bar to close to 
the Attachment box. 

Your response appears in the response field of 
the Attachments box and can be edited in this 
field if necessary.  

You can still edit you response message in this box. 
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           You can open, download and/or delete the selected document(s) using the links on the    
document’s item line or clicking on the buttons above the line items. Click OK when you are 
satisfied with your selections. 

 

           
 
 
  Once you click OK, the Attachment box shows the name of the inquirer to whom the attachment is 
being sent. Send on Save is automatically checked. 

 

 
 
When you are satisfied with the response and the attached documents, click Save or Save and 
Close. 

 
 
 

The selected document(s) will be listed here as line items.  

You can open, download and/or delete the 
selected document using the links on the 
document’s item line or clicking on the buttons 
above the line items. 

If you’re done, click on the Save and Close button and the 
message will be sent with the attachment, and the inquiry 
will be set to Solved and closed. 

Click on Add Files, Browse (your 
own machine) or Search (beyond 
your own machine), select the 
attachment(s). 

Send on Save is automatically selected for 
you. 

Shows the name of the inquirer to 
whom the reply and attachment will 
be sent. 

Send on Save is automatically checked when you 
add an attachment to your response.  This means 
that when you Save or Save and Close, the 
message will be sent with the attachment, and the 

inquiry will be set to Solved. 

Click OK when you are satisfied with your 
selections. 



40 

 

 
2.  Attach A File for Internal Use Only; will NOT be sent to inquirer 

To attach a document for internal use only (will not be sent to inquirer), click on the Internal 
Attachment tab when the inquiry is open on the screen.  
 

 
 

 To attach documents for internal use, do the following: 
1. Click on the Internal Attachments tab 
2. Click on Add Files. 
3. Find and select the documents  (Browse looks at your machine only; Search goes outside your 

machine) 

4. When the documents are successfully attached, the paper clip symbol   will appear on the 
Internal Attachments tab label and the document will be listed on the tab screen.  You can 
open, download or delete the document that has been attached by using those respective links 
at the right end of the line item or by choosing buttons for those functions (functions will be 
applied to the highlighted document in the attached document listings. 
 

     
 

 

 
 

 
 
 
 

 
 
 

 
 
 

Viewing attached files: 
To view a file attachment that was appended to the inquiry by a VA employee for internal use, click on 
the Internal Attachments tab to see and open all the files that have been attached to the inquiry.  

 

 
 

 

You can also open, download 
and/or delete the attachment(s) on 
that line item using these 
selections instead of using the 
buttons on the top of the tab 
section. 
 

You can 
Open the 
highlighted 
document if 
you want to 
make sure 
it’s the 
correct one. 

You can 
Delete the 
highlighted 
document if 
you wish. 

The Download 
button allows you to 
save the highlighted 
file/document to your 
machine in another 
location. If desired. 

1. Click on Internal Attachments tab. 

Internal Attachments tab is where any 
files/documents can be attached for internal use. 

Attachments listed are all files attached for internal use. List 
does NOT include files sent only to the inquirer. 

3. Browse your own machine or Search beyond your own 
machine to find the file/document(s) and select the items to attach. 
 
. 4. When the documents are successfully attached, the 

paper clip symbol will appear on the Internal Attachments 
tab label. 

.  

The document(s) will be listed on the 
Internal Attachments tab screen.   
 
. 

2. Click on the Add Files button. 
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Info Submitted via Web Entry Form Tab 

 
 
These tabs are read only and reflect the specific information that was input via the customer 
entry form on the VA website. If the inquiry was constructed by a VA employee from inside the 
system, no information will fill these tabs.  
 
These tabs provide historical information only and information in the fields in these tabs is not 
searchable.   You may need to copy information in these fields into the contact record to make it part 
of the contact record and make the information searchable. 

 
Subtabs contain information about the inquirer (who may or not be the veteran), the veteran, and 
information about a dependent of the veteran, depending on what the inquiry scenario is.  For 
example:  
If the inquirer is the veteran, the vet info will pertain to the inquirer. 
If the inquirer is not the veteran and is inquiring about or on behalf of a veteran, the vet info pertains 
only to the veteran. 
If the inquirer represents the dependent of a veteran, there will be information about the inquirer, the 
veteran, and the dependent. 

NOTE:  The only SSN that we ask for is the SSN of the veteran.  If you copy an SSN 
into a contact record, be sure it is copied to the veteran’s contact record and not to 
the contact record of the inquirer or the dependent if other than the veteran. 
 
Inquirer’s Info subtab: 

 
I 
Veteran Info Subtab: If the veteran is also the inquirer, the information here will pertain to the 

inquirer. If the veteran is NOT the inquirer, this information belongs to the veteran. 

 
 
Dependent Info Subtab: 

 

The only SSN we ask for belongs 
to the veteran. Be sure it appears 
on the correct contact record and is 
not attributed to anyone other than 
the veteran. 

We ask if the veteran is deceased. 

We ask for the relationship between the 
inquirer and the veteran if inquirer is not the 
veteran. 

We ask for the relationship between the 
dependent and the veteran if a dependent is 
involved. 
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Audit Log tab 
The Audit Log tab displays the entire history of the inquiry opened on your screen from the moment 
it was first submitted; the most recent action at the top of the list. 

 
 
IRISInfo Website Help tab 
The IRISInfo Website Help tab goes directly to the IRISInfo Intranet website at 
http://vaww.gov/irisinfo/irisguides.asp     There are links to IRIS documents, including the instruction 
manual, the IRIS Participants Dropdown Listings, a list of all Answers/FAQs in the IRIS FAQ 
Knowledge Base, a list of all Standard Text Answers, links to recorded training, documents that 
address Internet browser settings, etc.   
 

 
 
Tabs across the top (or the bottom) of the screen; tab for each open item 
When you open more than one item/screen at the same time, each item has a tab that appears at the 
bottom of the screen showing the name of the contact if a contact record is open or an inquiry number 
if an inquiry is open on your screen, On the following screenshot, there is the My Group’s Inquiries 
tab (default screen), an open inquiry for which the reference number displays on the tab, and a 
second open inquiry that shows its reference number.  

 
 

 
To utilize the tabs and take an action on a specific item, right click on the tab as follows. 

 
 
When you have a contact record or an inquiry displayed on your screen and you open something 
else without closing the first item, the new item will overlay the first and will display a tab on the 
bottom of the screen. All open screens will have tabs that display at the bottom of the screen in the 
same way Excel spreadsheets have tabs for multiple sheets in a spreadsheet. To get descriptive 
information about the content of a tab that that belongs to the item, move your cursor over the tab 
that has an inquiry number and the mouseover will display basic information about the inquiry. 
 
Mouseover Capability with bottom tabs 

Put your cursor over the tab for the item that you opened but did not close when you opened 
something else, and the mouseover will display basic information about the item. 

 

Audit Log displays the entire history of an 
opened inquiry from the moment it was first 
submitted. 

The mouseover will display basic 
information about the item when you put the 
cursor on the tab. 

http://vaww.gov/irisinfo/irisguides.asp
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Handling IRIS Inquiries: The Steps 
 
1. Open the IRIS.  The screen default if My Group’s Inquiries.  If anything else is displayed, click on 
My Group’s Inquiries to get to your workspace. 

 
i 
 
 
2. Select an inquiry by double-clicking on it to open it. 

 
 
 
 

 
 
 
 

Your workspace default is 
My Group’s Inquiries. 

Select an inquiry by double-
clicking on it. 

Message content 
is displayed here. 

Some of the customer entry information, Inquirer 
Details and Inquiry Details, is displayed here.  
Additional contact  information can be found on the 
Contact tab. 
 

Message tab is the default 
when inquiry is opened. 

When an inquiry is opened, a tab with the 
reference number displays on the bottom. 
You can close the inquiry it by right-clicking 
on the tab and choosing the close option. 
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3.  The Messages tab is the default tab when you open an inquiry. Read the message and 
determine if it needs to be re-assigned to another mailgroup.  If you determine that inquiry does 
not belong to your mailgroup and thus needs to be reassigned, do the following: 

 

 Reassign an Inquiry if it doesn’t belong to your mailgroup 
To reassign an inquiry to another IRIS mail group: Click on the Assigned field dropdown arrow 
and choose the correct mail group and its subset to which the inquiry will be assigned. Mail 
groups are listed alphabetically: all VA program offices start with VA, all NCA entries begin with 
NCA, all VBA entries begin with VBA; all VHA entries begin with VHA.  VHA facilities are listed 
by state; VISNs are at the bottom of the VHA listings and are shown as VHA-VISN X.  NOTE: 
You must pick a subset of a selected mailgroup.  If you pick a subset, that particular person will 
get an alert.  If that person belongs to a corporate mailbox, everyone in the group will receive the 
alert. 
  
See full listing of all mail groups in the IRIS, the order in which they appear, service area 
information, etc., at http://vaww.va.gov/irisinfo/irisguides.asp on the IRIS Participants  
 
Dropdown List document. Please create a direct link to this document or you can click on the 

IRISInfo tab on the opened inquiry.    When needed, open up the IRIS 
Participants Dropdown List document, place your cursor in any text, and do a control+F to 
open a search box. Enter your search term for a location or program office.  All occurrences of 
this term will be found so that you can find the correct one. 
 
You may wish to Add a Private Note before transferring if it would be helpful to the receiving 
location.  Once the receiving group is chosen and the Private Note is entered, click on Save 
and Close to save any changes/additions and move the inquiry to the new group. 
 
DO NOT EVER REASSIGN AN INQUIRY IN SOLVED STATUS; if you do, the receiving 
location will never know they have it because Solved inquiries go into another basket and are 
never seen unless searched for. 

 
 
 
 

 
 

                   
 
If you re-assign to another mailgroup, you may also need to change the Topic/Subtopic field 
to be compatible with the context of the inquiry. If the Topic and Subtopic pertain to a 
Regional Office or a Specific Medical Facility, you may need to select or change the 
appropriate location field when you change the topic and subtopic.

 
 

1. Click on Assigned dropdown arrow to see all mail 
groups in IRIS. See full listing of all mail groups in the 
IRIS, the order in which they appear, service area 
information, etc., at 
http://vaww.va.gov/irisinfo/irisguides.asp on the IRIS 
Participants Dropdown List document.  
 
 
 

2. Select the correct routing destination and a subset.   

 
If it is a VBA Comp and Pen destination, pick the 
subset that says PCT  

You may need to select or change the 
Topic/Subtopic field to be compatible with the 
context of the inquiry when you reassign.  

http://vaww.va.gov/irisinfo/irisguides.asp
http://vaww.va.gov/irisinfo/irisguides.asp
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View More Contact Information from the Customer Entry data 
The upper inquiry screen displays some, but not all, of the information entered by or on behalf the 
inquirer.  To access additional customer entry Information, click on the Contact tab and then click on 
the person’s name. Note: if two names are listed, it means that the inquirer submitted an inquiry on 
behalf of a veteran.  The name with the clicked radio button is the inquirer and the other is the 
veteran.  If three people are involved in the inquiry, three names should appear. DO NOT CHANGE 
THE RADIO BUTTON. When you click on the name, you will see the additional information submitted 
about that person/contact.  
 
 

 
 
 

 
 
In this example, the name clicked on is the veteran for whom the inquiry was submitted by another 
person/contact.  The contact record will open up. 

 

Click on the Contact tab for more customer entry info, if any. 
  

If two names are listed, the (2) will appear on the tab; it means that the inquirer 
submitted an inquiry on material to or on behalf of a veteran.  The name with the 
clicked radio button is the inquirer and the other is the veteran.  When you click on 
the name, you will see the additional information submitted about that 
person/contact. 

Additional information is displayed when 
the name is clicked. The name of the 
contact (inquirer and/or veteran) appears 
on the top of the information box. 

3. You can enter a Private Note before you 
Save and Close, by clicking on Add>Private 
Note if additional information will be helpful to 
the mailgroup to whom jurisdiction is being 
transferred. 

4. Click Save and Close at the top of the 
screen to save the changes/additions and 
transfer jurisdiction. 

If three names are listed, it means that the inquirer submitted an inquiry material to or 
on behalf of the dependent of a veteran.  The name with the clicked radio button is 
the inquirer; the other names would be the veteran and the dependent. When you 
click on the name, you will see the additional information submitted about that 
person/contact. The contacts tab will show (3). 
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4. Determine by what means the inquirer wants a response. The requested Type of Response field 
is on the upper right of the inquiry screen.   There are three choices: E-mail, US Mail and Telephone. 
NOTE: If the inquirer wants other than an e-mail response, s/he probably did not enter an email 
address.   No reply can be sent electronically via the IRIS without an email address.  

 
 
 
 
 
If the preferred Type of Response is: 
 
Telephone:  You must call the inquirer at the phone number provided to resolve the inquiry.  You 

must then enter a Private Note describing your resolution and manually change the 
status code to Solved.  See Private Note instruction below. 

 
US Mail:  You must prepare and send a written communication through the mail and then you must 

then enter a Private Note describing your resolution and manually change the status code 
to Solved.  See Private Note instruction below. 

 
E-Mail: Send Response via Inquirer E-mail Address 
Click the Add button on the Messages tab.  This function is used to enter a Response, add an 
additional request from the inquirer to an existing inquiry using Customer Entry and/or enter a 
Private Note.  
 
 Private Notes are never sent to the inquirer and are for internal use only. However, full printouts 
include private notes.  If a FOIA request requires the disclosure of IRIS inquiries that are printed 
out, the inquirer will see them.  Choose your words carefully when entering Private Notes.   
Whichever function you choose from the dropdown selections of the Add button will drive what you 
do next.  Your selection is displayed over the empty entry box. 
 
See next screenshots for directions about each function. Also see Tools for Responders section for 
help tools. 
 

 
 
 
5.  Add a Response, Additional Customer Entry information, Add a Private Note 
If the inquirer has supplied an email address and asks for an electronic response, select Response 
and type your response in the box.  YOU WILL ONLY SELECT RESPONSE WHEN YOU ARE 
SENDING A RESPONSE TO THE INQUIRER’S EMAIL ADDRESS. Be sure to comply with Privacy 

Click on Response. You will only use this option if the 
inquirer has an email address and requests an email 
response. You can also add a Private Note for internal use 
if needed. 

The requested Type of Response 
field is on the upper right of the 
inquiry screen. 

 
 

On Messages tab, click on Add 
button. 

No reply can be sent electronically 
via the IRIS without an email address. 
No email address means you must 
respond by the other response 
preference and enter a Private Note 
saying what you did to resolve the 
inquiry. 
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rules about response content and do not use acronyms.  Spell everything out. If you don’t like your 
response and wish to remove all of it, click on the delete button on the upper right of the response 
box to erase the response and start all over again.   

The spellchecker  is automatically turned on when you are typing your response.  Any 
misspelled words will be underlined in the text just as in Microsoft Word.   You can override the Spell 
Checker or run it by clicking on the Spell Check button on the top of the screen.  
 
Please see the Tools for Responders section below for tools available for the response process. 

 
            
 
 
 
 
 
 
 
Privacy Rules:   CAUTION:  YOU MUST, IN ALL CASES, OBEY THE PRIVACY 
REQUIREMENTS THAT APPLY TO IRIS INQUIRY RESPONSES. Privacy Requirements for 
Responses:  Although the IRIS operates on a Secure Socket Layer to protect the transmission of 
information into VA, the opposite is not true.  Our electronic responses leave VA’s secure 
environment via the Internet into un-secure territory since most of the public operates without the 
same protections that typically apply to commercial endeavors.   VA cannot know if the inquirer is 
opening his/her response on his/her own computer, in a public library, or anywhere else.  For this 
reason, we may not include personal, identifying information in our responses (i.e., specific 
personal data from a medical record, Social Security numbers, bank account numbers, etc. 
until such time as we can authenticate and password veterans into the system to offer a 
higher level of protection to our IRIS electronic communications.)   If it is necessary to provide 
personal information in a response, you should respond to the inquirer by telling him/her that you 
must respond by phone or by surface mail with the desired information because of the personal 
nature of the desired response.    

 
Attachments: Adding Attachments to Response; Adding Attachments for Internal Use 

 
Add attachment to response If you need to add a document to send with your response, be sure to 
attach it using the attachment capability in the response box. 

  

Click on the attachment tool (dotted vertical area) 
on the left side of the response box to send 
attachment to inquirer with response.. 

If the inquirer asked for an electronic response, 
select Response from the Add button selections, 
Response mode shows at the top of the blank entry 
box.   

Type your response in 
the Response box.  

If you don’t like your response and wish 
to remove all of it, click on the delete 
button to erase all the contents of the 
response box and start all over again. 

 

You must check Send on Save to send the response 
message to the inquirer’s email address.  It will be 
sent when you click Save or Save and Close. Note:  
If another party is cited on the inquiry and that 
other person also has an email address, the 

response will be sent to that person also. 
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You will have a record of the document sent with the electronic response to the inquirer.  You can 
click on the document to open it. 

 
 
 
 
Add attachments for internal use   If you need to attach documents for internal use, use the 
Internal Attachments tab. Once successfully attached, a paper clip icon will appear on the Internal 
Attachments tab. 

 
 
 

 
 
 

Add Additional Customer Entry (more questions/updates from inquirer) information to an 

existing inquiry based on additional contact with inquirer: 

 Click on Customer Entry and then select the method by which you got this additional 
information from the inquirer. Then enter that information in the box. 
 

 
 

 
 
 
Add A Private Note 
To add a Private Note, select Private Note from the Add dropdown. The Private Note indicator will 

show at the top of the entry box.  
 

 

 
 

 The area below 
will be labeled 
Inquirer Entry. 

 

Enter the 
additional info 
from the 
inquirer in this 
space. 

Click on the By 
Phone dropdown 
and select the 
method by which 
you acquired the 
additional info to be 
added to the 
existing inquiry 
from the inquirer. 

Pick Private Note from Add 
dropdown.  

Private Note indicator will display at 
the top of the box. 

Click on the Internal Attachments tab if you want to attach documents for 
internal use. As soon as they are attached, a paper clip will appear on the 
Internal Attachment tab label. 

  

 Click on Customer Entry.  

Click on the Add Files, Browse (your own machine) or Search 
(more than your own machine) for documents and select them. 

This document was sent 
with this electronic 
response. The 
attachments symbol 
appears, the number of 
attachment is noted and 
the name(s) of the 
attached document(s) 
are listed. 
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Type in your note; this note will not go outside of VA. It is internal only. However, if the inquirer and/or 
veteran view a printed copy of the inquiry for any reason (i.e., FOIA request), all parts of the inquiry 
will display including private notes. Choose your words carefully.  If you decide not to retain the 
private note that you just typed in but did not save, you can use the delete button to remove it. Do 
NOT include any disrespectful or other inappropriate language in a private note.  Private notes may 
be seen by others and will appear on print-outs. 

 
 
 
 
 
6. Once you have completed your response, you will need to do two things: 1) click on Send on Save 
and then 2) either Save or Save and Close it.  When you are in Response mode, the Send on Save 
feature becomes available. You must check this box for the electronic response to be sent.  When 
you have entered a response AND clicked Send on Save, the status field will automatically be set to 
Solved unless you manually reset it to something else. 
 
Once Send on Save is clicked, the response will be sent as soon as you Save this inquiry, even if it 
remains open on your screen. You will then need to click Save (will send response and save all you 
have done, but will leave the inquiry open on your screen) or click on Save and Close which will send 
the response, save your work and also close the inquiry. NOTE: If you need a printout of the inquiry 
that includes your response, click Save, NOT Save and Close. Then do the print out for a complete 
copy and then Close.   

 

 

 
 
7. Print a copy of the inquiry that you’re working on, if necessary 
If you need a printout of the inquiry that includes your response, click Save, NOT Save and Close. 
Click Save, Print a complete copy and then click Save and Close.  Any printout will ONLY contain 
information that is saved, so if you haven’t saved the inquiry with the response, the system will only 
print the inquiry without the response.  Some of the PII fields will not appear on a print copy if the field 
was not completed. For example, if a service number or claim number was not entered in their 
respective fields and are thus blank, neither the service number nor the claim number field will appear 
on the print out at all.

 
 

Type in your note. 

If you don’t want the note and wish to remove 
all of it, click on delete. 

Click Send on Save when you are ready to send your 
response.  You must click this button for a response to be sent.  
Clicking this button after entering a response in the Response 
field will automatically reset the status to Solved unless you 
manually change it to something else. 

You will then need to click 
Save (will send response 
and save all you have done, 
but will leave the inquiry 

open on your screen) OR  

Click on Save and Close to send response, 
save your work and also close the inquiry. 

Print button is at the top of the screen.  When clicked, 
it will print ONLY what has already been saved. 
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Tools for Responders: There are tools available for responders when an inquiry has been 

opened up that appear above the response box on the Open Inquiry Toolbar. They are: 
Smart Assistant: Use to have the system match keywords in the inquiry with FAQs in the knowledge 
base that can be embedded in responses. 
Search Knowledge Base: Allows responder to search the FAQ Knowledge Base manually to see if 
any suitable FAQs can be embedded in responses. 
Standard Text: Use to find ―canned answers‖ about information often requested in inquiries; 
Standard Text can be embedded in the response box. 
Increase Font Size:  Use to increase the size of the font that displays in the inquiry. 
Undock allows the inquiry thread (multiple responses, updates by inquirer, Private Notes) to be 
displayed in a completely separate window.  Use only if there is an extensive history thread for the 
specific inquiry. 

 
Open inquiry toolbar 

 
 
 
 
 
 
 

 
 
 
 
 

Spell Check    The Spell Check function is automatically available when you are typing a 
response, a Private Note, and/or performing customer entry on behalf of inquirers.  It works in the 
same way MS Word works by underlining the misspelled text when you type something incorrectly.  
You can control the spell check function on an open inquiry by using the Spell Check   button on the 
top ribbon and can override it if necessary.  
 

   
 
If the word is unlined as misspelled, right-click on the word and the Spellcheck dropdown will open 
with word possibilities, etc.  Select what you need and click on it. 
                                 

                                
 
 
Standard Text and Hotkeys 
 
The IRIS contains a number of folders containing Standard Text. These are ―canned‖ responses that 
can be used again and again because the inquiries received by any given mailgroup include the 

Smart 
Assistant: Use 
to have the 
system match 
keywords in the 
inquiry with 
FAQs in the 
knowledge base 
that can be 
embedded in 
responses. 

 

Search 
Knowledge 
Base: Allows 
responder to 
search the FAQ 
Knowledge Base 
manually to see 
if any suitable 
FAQs can be 
embedded in 
responses. 
 

 

Standard Text:  
Use to find ―canned 
answers‖ about 
information often 
requested in inquiries; 
Standard Text can be 
embedded in the 
response box. 

 

Increase 
Font Size:  
Use to 
increase the 
size of the 
font the 
displays in 
the inquiry. 

Undock allows the 
inquiry thread 
(multiple responses, 
updates by inquirer, 
Private Notes) to be 
displayed in a 
completely separate 
window.  Use if 
there is an extensive  
history thread for the 
specific inquiry. 

The word ―work‖ has been misspelled as ―worrk‖.  
It is underlined, indicating that it is misspelled. 
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same questions on a regular basis.  Responders can use any of the items in any folder if useful. 
Clicking on the desired Standard Text response will embed that canned in the response box.  Once 
embedded, the Standard Text response can be edited, added to or removed.  A complete inventory 
of all Standard Text responses including folder, label and content can be found at 
http://vaww,va,gov/irisinfo/irisguides.asp or accessed via the IRISInfo Website Help tab.      Note: 
To add a Standard Text response to a folder, please contact the VA IRIS System Admin Group.  
That response must be appropriately vetted before it is sent to the IRIS Admins to post. 
 
When you open an inquiry, the responder tools appear above the response box. If you wish to utilize 
a canned answer, click on the Standard Text button above the response box. 
 

 
 
Click on the folder that contains the Standard Text that you want to use.  Find and open the folder, 
find the label for the Standard Text response you are looking for. Click on it once to preview the 
content and/or click twice on it to embed it in the response box. 
 

   
 

 
 
Preview a Standard Text Response and Find Hotkey Number 
Click ONCE to preview the standard response and TWICE to embed the Standard Text in the 
response box. If in Preview mode and the response is acceptable, click OK. NOTE: You can edit or 
delete all or part of a Standard Text response once embedded in the response box. 
To obtain the hotkey number, use the Preview function which displays the hotkey number as well 
as the contents of the Standard Text response. The hotkey number is a shortcut for using the same 
Standard Text response all the time simply by entering the ID number. Mailgroups that use them to 
answer the same questions over and over again find the hotkey shortcuts useful.  See UsIng the 
Internal Hotkey Number for embedding Standard Text in Responses below to learn how to use 
hotkeys. 

 

Standard Text button allows you to 
search, locate, and embed canned answers 
in responses. 

Click the folder that contains the Standard 

Text you want to display 

When you click the label of the Standard Text ONCE, the 
content will appear in the Preview screen. If the content is 
what you’re looking for, click okay to embed in the 

response box. Otherwise click cancel. 

Click on the Standard Text Response 
ONCE to preview the content, or click 
on it TWICE to embed the response 
into the response field. 

You can also click on Expand All to list the content of 

every folder.  You can use any canned responses 

from any of the folders if they are useful. 

 

Hotkey number is a shortcut for using the same Standard 
Text responses all the time simply by entering the ID number. 
See UsIng the Internal Hotkey Number for embedding 

Standard Text in Responses below. 

http://vaww,va,gov/irisinfo/irisguides.asp
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 You can edit or delete the embedded text if necessary. 

 
 

UsIng the Internal Hotkey Number for embedding Standard Text in Responses 
 
What is a Standard Text hotkey? A hotkey is a shortcut button that asks for the internal ID number 
of a Standard Text response.  When the internal ID number is entered, the corresponding Standard 
Text response is embedded in the response box.  
How do you find a hotkey ID number? You must first find the Standard Text item in the Preview 
mode to determine its internal ID number. (Click on the desired Standard Text item ONCE to see a 
preview of the content and find the hotkey number.)   
 
If you know the internal hotkey number of the Standard Text response that you use all the time, you 
can use a shortcut using the F8 key on your keyboard.  Put your cursor into the response box and 
click on the F8 key.  A box will open up asking for the internal number. Enter the number and click on 
Enter to embed the canned response. You can edit or delete it if necessary. 

 
 
 
 
Smart Assistant (Key Word Match with existing Answers/FAQs) 
 
Smart Assistant will return any FAQs that match any of the keywords in the inquiry.  If any existing 
Answers/FAQs can be in used as a response or included in a response, you can add the text or the 
link to the text in the response box by clicking on the action to the right of the Answer/FAQ that you 
want.  If this is an Answer/FAQ that you will use with great frequency, make note of the ID number to 
use the hotkey function. 
 
When you are working in the response box of an open inquiry, you can click on Smart Assistant to 
see if any keywords exist in the inquiry that match an Answer/FAQ and, if there are any results to that 
keyword search, you can determine which Answer/FAQ it is and what its number is. 
 

 
 
 If there are no results, no items will show. 

 
 
If any matches to keywords are found, results will be shown as line items. You can click on any of 
them to see full content of that item. You will see the internal ID number on the left-hand column of 
the line item.  If selected, you can embed as Text or as a Link in the response box. 
 

 

Once embedded, you 
can edit, enhance or 
delete the text. 

Enter the internal hot key number into the box that opens up 
when you click on the F8 key while your cursor is the response 
box, and click on the Enter key.  The response will embed in the 
response box and can be edited or deleted as necessary. 

Click on Smart Assistant to see if any 
Answers/FAQs match the keywords in the 
inquiry. 

Answer/FAQ internal ID 
number 

If any existing Answers/FAQs can be in used as a response or 
included in a response, you can embed the text or the link to the 

text in the response box by clicking on the Action link 

No results message. 
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Search Knowledge Base: Search Answers/FAQs manually and hotkeys 
 
Search Knowledgebase can be used when you are working in the response box of an open inquiry. 
You can click on Search Knowledgebase to find an Answer/FAQ yourself. 
 

 
 
In the Search Knowledgebase box that opens, type in the word or phrase you’re looking for by 
typing in the similar phrase or exact search word you’re looking for and then click Search.  
 

 
If there are no results, the screen will say ―There are no items to show in this view‖. 
 

 
 
 
If there are results, they will be listed as line items. 

 
 
 
You must open the Answer/FAQ by double clicking on it to preview the content of the Answer/FAQ 
and to determine its Answer ID number. 
 

 
 

 
Using the Internal Hotkey Numbers for Answers/FAQs  
What is a hotkey? A hotkey is a button that asks for the internal Answer ID number of an 
Answer/FAQ and then embeds that Answer/FAQ in the response box.  
How do you find a hotkey ID number? You must first find the Answer/FAQ to determine its internal 
ID number.  See above. 
If you know the answer ID to append, put your cursor into the response box and use the F9 key to 
append the FAQ text (preferred method), enter the answer ID number and then click Enter. 

Then click 
Search. 

Click on Search Knowledge Base 

Results will display under search 
parameters if any are found. 

Answer ID number 

If no results are returned, this ―no item to show‖ message will display. 

Type in the 
similar 
phrase or 
exact search 
word you’re 
looking for. 

Search Knowledgebase box  
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OR  
use the  F10 key to append a link to that Answer/FAQ in the response box. In the pop-up window, 
enter the answer ID and click Enter.  

 
 

Change Font Size 
This function will change the font size of the inquiry thread text or anything you type into Response, 
Inquiry Content and/or Private Note to make it easier to read. 
. 

 
 
 
 
Undock 

 
 
 
Send on Save, Save and Save and Close Buttons 
 
Click Send on Save when response is entered so that the electronic response will be sent (inquirer 

must have an email address and request an electronic response). If this button is not checked, the 
inquirer will not receive anything when you Save or Save and Close. 
 

 
 
 
Save and Save and Close buttons on the ribbon at the top of the screen 

 
 
 
Print an Opened Inquiry- A Two Step Process 
You must 1) select Print using the Print button; this will give you a print preview of the printout.  You 
must then 2) click on File>Print on the upper left hand corner as follows: 
 
To print an opened inquiry, use the Print button at the top of the inquiry.  NOTE: The printout will 
include ONLY the data that has been Saved in the inquiry. If you have typed in a response but 

When you have entered your response to be sent electronically, click the Send on 
Save button, so that the response will be sent when you click Save or click Save 

and Close button at the top of the screen. 

Save saves your work but leaves the inquiry open on your screen. 
Save and Close saves your work and also closes the inquiry. 

Change font size of the inquiry thread text.

 

F9 embeds the Answer/FAQ text to the 
response field.  Once embedded, you can edit 
the text in any way you see fit, or you can 
delete it if you decide not to use it. 

F10 appends the link to the Answer/FAQ in the response field. 

Clicking on undock will expand the message 
tab screen to see a lengthy message history. 

 



 55 

haven’t saved it, the print will not show the response. Clicking on the Print button will display a 
preview of the printout. 
NOTE: If the inquiry does NOT involve a dependent, the dependent information fields will not display. 

 
 

 
 

 

 
Searching for Inquiries: Three Methods 
 
The Three Search Methods:  There are three search methods to find a particular inquiry or a 

particular contact (inquirer, veteran or other contact). They are:  
1. Quick Search using inquiry number, last name and/or first name and/or middle initial and/or 

email address, and/or the SSN 
2. Search by choosing more parameters 
3. Wildcard search using partial data and the % (percent key or using the * star/asterisk 

wildcard for phone numbers. 
 

1.  Using Quick Search on the left navigation pane—Search for a specific inquiry by its full 

inquiry reference number, or by contact data (last name and/or first name and/or email address 
and/or SSN.    

 
 
If you select Inquiry Search from the Quick Search dropdown, the fillable Inquiry # field will appear.  
You must enter the entire inquiry reference number or a partial string with the % wildcard function. 
Results will appear on the right side of the screen. 

 
 
 

Quick Search 

 

1. Click the Print button on the ribbon at the top of the inquiry. A print preview will 
display. The printout will include ONLY the data that has been Saved in the inquiry. 
Note: unfilled PII fields will not display on the print copy; i.e., if no service number was 
entered, the service number field will not appear on the print out. 

2. Click File on the upper left and then click Print to produce the paper 
print out. 

Exact inquiry number calls up and 
opens that inquiry.  

Enter exact inquiry number  
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Wildcard inquiry number search: (Example is all inquires dated Sep 23, 2010 assisgned ot 
your mailgroup   100923% 

   
 
 
If you select Contact & SSN Quick Search from the Quick Search dropdown, the fillable fields for 
Last Name, First Name and Middle Initial, Email, Service #, Claim # and SSN will appear. You can 
fill in one or more of the fields. Results will appear on the right side of the screen. 

                
 
 
Wildcard Search by Contact & SSN Quick Search 
 
Search string: (example: all contacts whose last name begins with ‖Johns‖; enter Johns%) 
           Search     Results 

  
 
 

2. Search by choosing parameters: Find an Inquiry or Inquirer or Navigate to Solved 
Inquiries   

You can enter a search term(s) in the fillable fields to find an inquiry or group of inquiries.  You can 
search using any one of the fillable fields on the Search window: Inquirer Last Name, Phone Number, 
Email Address, Last Name, First Name, Claim Number. Service Number, or Inquiry Number. You can 
also search multiple mailgroups.  You also use this function to navigate to your Solved inquiries. 

 
Click Search button and enter your parameters. 

 Search button  

Partial 
inquiry # 
with % 
wildcard  

Search returns all inquiries that 
contain the wildcard string. 
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Navigate to Solved Inquiries 
 
To navigate to your Solved inquiries, click on the Search button, select Solved in the Status field 
of the Search box.  Leave the Groups default at Logged In (this is your own mailgroup) and then 
click Search button on the bottom right.  All of your Solved inquiries will appear on the screen.  

 
 

 
 
Results will display all Solved inquiries for your mail group for the last six months.  Once inquiries 
are in Solved status for more than six months with no activity, they are archived and then purged 
from the system after 19 months. 
 
To navigate back to your open inquiries, perform the same steps, clicking the status codes other 
than Solved or click the Reset button.  

 
 
 

3.  Wildcard Search 
You can search for an inquiry that belongs to your mailgroup with only a partial name, partial claim 
number, partial summary string, etc. by using the percent % character (uppercase on the 5 button).. 
You set the parameters for status codes that you want to search (Solved only, All Status Codes, etc. 
and then fill the specific search field.  For example, if you want to find all the inquiries with the word 
―test‖, you would enter %test in the Summary field.  See screen shot.  

You can search using any one of 
the fillable fields on the Search 
window:  
Inquirer Last Name, Phone Number 
Email Address, Veteran Last Name 
Claim Number 
 Inquiry Number 

Once you have filled in the search 
parameter, click Search 

1. Select only Solved in the Status column 

Click Search. 

Click Reset button to go back to your 
default screen. 

Leave the Groups default at 
Logged In (this is your own 
mailgroup). 
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Set Wildcard Parameters 
Enter the status code parameter that you want searched and then enter % followed by the data 
you’re looking for. In this example, you are looking for the word ―test‖ in the inquiry threads of all 
inquiries assigned to your mailgroup in all status codes. 

 
 
 
Search Results Screen 
Search results for this example come back as line items on a new screen.  The search results are all 
of the inquiries belonging to this mailgroup that have the word ―test‖ in them and includes all status 
codes. 
 

 
 
Reset will clear the search results and return to the Inquiry Console Screen after your Search is 
completed. Click on the Reset button and wait a moment for the screen to refresh. 
 

 
 

 
      

Summary of Steps to Take Action on an Inquiry 
 
(For full description and use of each button/function, please see earlier pages with descriptions of 

each individual button.) 
 
There is a specific order of actions that need to be taken for the IRIS to perform properly. Be 
sure you take all the necessary steps in the proper order as follows: 
 
1. Go to the IRIS login screen and enter your access codes. REMEMBER THAT ACCESS CODES 
ARE CASE SENSITIVE. 

                                   

Enter % first followed by the 
data you’re looking for. In this 
example, you are looking for the 
word ―test‖ in the inquiry threads 
of inquiries assigned to your 
mailgroup. Enter %test. 

Set your parameters for 
status codes that you 
want to search or Select 

All for all status codes. 

Search results for this example 
come back as line items on a 
new screen.  Results are 
inquiries that belong to this 
mailgroup that have the word 
―test‖ in them. They include all 
status codes. 

Click on the Reset button to 
return to your home screen. 
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2.  You should go directly to the My Group’s Inquiries screen.  Select the inquiry that you want to 
work on from the listing on the top half of the screen by double-clicking on the entry. 

 
 
3. After opening and reading the inquiry, determine if it correctly belongs to your mailgroup. If 
not: 

 1) reassign it promptly by choosing the correct assignment location from the dropdown box.  
Mail groups appear in alphabetical order as they appear.  All VA organizations begin with VA, 
NCA organizations begin with NCA, all VBA locations begin with VBA, VHA with VHA, etc.  
For a complete description of mail groups and their service areas, etc., go to 
http://vaww.va.gov/irisinfo/irisguides.asp and check the IRIS Participants Dropdown Listing 
document (use Control F to search the document).Select the correct destination from the 
dropdown list in the Assigned dropdown box.  

 2)  If the Topic and Subtopic in the field below are not compatible with the mailgroup to which 
you must reassign the inquiry, change it to the correct Topic and Subtopic prior to 
reassigning.  If the Topic and Subtopic are related to some VBA functions or to a specific 
medical facility, you may have to fill out the applicable RO or VAMC locations fields using the 
dropdown selections. NOTE: Not all Topics/Subtopics require the use of the Location 
fields.  Entries coming from the website will have these fields completed already. Examples: 
 
VBA Example:  

 
 
 
VAMC Example: 

 

1) Use Assigned dropdown to find and 
select correct mailgroup and subset of 
that mailgroup.  

2) Correct the Topic and Subtopic to 
ensure compatibility with the mailgroup 
of reassignment if necessary 

3) If the Topic/Subtopic is All Health & 
Medical, pertaining to a Specific 
Facility, select the VAMC from the 
dropdown. 

1) Use Assigned dropdown to find and 
select correct mailgroup and subset of 
that mailgroup.  

2) Correct the Topic and Subtopic to 
ensure compatibility with the mailgroup 
of reassignment if necessary 

3) If the Topic/Subtopic is 
Compensation,, pertaining to Filing for 
Benefits, select the RO location from 
the dropdown. 

http://vaww.va.gov/irisinfo/irisguides.asp
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4) Click Save and Close. This will transfer the jurisdiction of the inquiry to the new 
destination.  The screen will then refresh with the reassigned inquiry removed.   

              
 
5.  To add a response and/or internal note, click the Add button and enter the Response and/or 
Private Note.  You can use Standard Text or an FAQ as your response or in addition to your 
response. If you’ve done all the steps that apply to this inquiry, click Send on Save to send the 
response and click Save and Close.  If you aren’t done, use the following steps. 
 

 
 

 If you wish to insert a pre-written answer, click on the Standard Text button to access the 
pre-written answers.  If you find the one you want, click on it and the answer text will 
automatically insert into the response box.  You can edit that response in any way that you 
want or delete all of it if you decide it’s not what you’re looking for. 

 
 

 If you want the IRIS to suggest a response based on keywords found in the inquiry that 
match an FAQ, click on the Smart Assistant button.  A list of any result will appear on the 
screen and you can select any of them that you find suitable and embed the text in the 
response box.  You can edit or delete any of that embedded text. 

                         
 

 If want to search all the FAQs manually to find information for your response, click on the 
Search  Knowledgebase button and you can manually go through the FAQs to find what 
may be useful to you. If an FAQ will work, you can click on it and embed it in the response 
box.  You can edit or delete any of that embedded text. 

                               
 
 

 If you need assistance from someone not in the IRIS to be able to respond to the inquiry, 
you will need to  

o Request assistance via regular Outlook email.  If you need to include personal 
information from the inquiry, you must encrypt the email message.  If you need to 
copy inquiry content, highlight the content to be copied, click on Control+C to copy 
and then paste into the email message using the paste function or Control+V.  
NOTE: If you want the email message recipient to see everything, click on the Print 
button to get a preview of all the inquiry data and do a Control+A to highlight 
everything. Then do Control+C and then Control+V to paste into the email 
message.  

Add button 
dropdown. 

Standard Text button 

Smart Assistant button 

Search Knowledgebase button 

4) Click Save and Close to make the 
changes and transfer the inquiry. 
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o Reset the status of the inquiry to Additional Information Requested or other 
suitable status code—(NOT Solved or Solved-Duplicate) so that the inquiry stays 
on the Open Inquiry Console until you are able to reopen it and answer it.  If you 
change to Solved or Solved-Duplicate, it will be moved to another basket and you 
won’t be able to find. It. 

o Enter a Private Note annotating the request you are making for additional 
information 

o Click Save or Save and Close unless you want to attach documents.  
 

6. a To attach documents to an inquiry: You can attach VA files and documents to your response 
that is sent to the inquirer.  You can also attach files for internal use only.  Click on the dotted vertical 
lines on the margin at the left of the response field. 

 

 
       
 
    b. To attach documents for internal use only, click on the Internal Attachments tab and attach 
any documents using the Add button.  When an attachment is added for internal use, the paperclip 
symbol will appear on the Internal Attachments tab label. 
 

 
 
 
7. Click the Send on Save box at the bottom of the screen once you have typed in a response. This 
box is automatically checked if you add documents to send with the response. 
.  

 
 
8. To complete the inquiry activities, click on Save to send the response and record your actions and 
leave it open on your screen, OR click the Save and Close button to send the response, record your 

Open a new Outlook email.  Highlight the 
data to be copied.  Do Control+C to copy 
and then paste the data into your email 
message. If any personal information is  
copied, you MUST use encryption. 
 

Click between arrows on left side margin to attach documents to the 
response.  

  

Click on Internal Attachments tab to attach documents for 
internal use. 

Send on Save button will send the response 
and any response attachments when you 

Save or Save and Close.  . 

If you want the email 
message recipient to see 
everything, click on the 
Print button to get a 
preview of all the inquiry 
data and do a Control+A to 
highlight everything. Then 
do Control+C and then 
Control+V into the email 
message. 
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activities and also close the inquiry.   If you want to print a copy of the inquiry that includes your 
response, click on Save to save your work including the response and leave the inquiry open on 
your screen, then Print, and then Save and Close. If you Save and Close and subsequently decide 
to print the inquiry, you will have to navigate to your Solved basket to retrieve it or call it back from 
your Recent Items list on the left navigation pane and then print it. 
 
 
 
 

 
 
 
Multi-select:  Performing an identical action on more than one inquiry at a time 
The Multi-select feature allows you to take an identical action on more than one inquiry at one time 
rather than performing the same action on each inquiry individually (exact same response, exact 
same reassignment, etc.). This feature is most often used on duplicate inquiries from website visitors; 
see section on Duplicate Inquiries below. 
 
Examples of its use:  

 If VA has recently released a news item that causes you to receive a large number of 
inquiries about the news item, you may wish to send the same response to all of them. Using 
multi-select, you can write one response and then respond to all the inquiries at once.  

 If you receive a number of inquiries that belong to another mailgroup, you can reassign all 
selected inquiries to the same routing destination.  

 
To use this feature, do the following: 

1. Press the Ctrl key while selecting each inquiry so that they are all highlighted. 
(Background highlighting is very pale.)   

2. Click on the Open button when you have highlighted the selected inquiries.  
 

 
 

3. The Multi Select screen will open up that will allow you to perform the same activity on 
all of them. Both the box label and the tab at the bottom say Incident Multi Edit.  You 
can do any of the following: 

 You can reassign all to the same routing destination using the Assigned field 

 You can change the status of all of them. 

 You can enter the same Response and/or Private Note for all of them by clicking the 
Add button and performing the action. If you enter a response, you must click on 
Send on Save. (button on upper left of response box). 

Save will record what you did and send an electronic response if you entered one 
(provided Send on Save is clicked) but will not close the inquiry. When the inquiry is still 
open on your screen, you can click PrInt and everything that has been saved to the 
system, including your response will print. 
 

Save and Close will save all transactions and close the inquiry. When the 
inquiry is set to Solved it will move to your mailgroup’s solved basket.   

1. Hold down the Control key and click on all the inquiries 
on which you want to perform the exact same action (re-
assign all to the same mailgroup, send the same identical 
response, etc).  The selected inquiries should all be 
highlighted. 

2. Click on Open button. 
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 When you’ve taken the action, record it in the system, click Save or Save and Close. 

 
     

                        
 
Duplicate Inquiries: Duplicates can be created in two ways:  
1)  by inquirers (repeated copies of the same inquiry go to the same mailgroup) or  
2)  by VA staff who purposely create duplicates when a single inquiry addresses multiple issues that 
must be addressed by more than one mailgroup. (subject line says ―copy of‖ at the beginning of the 
subject line.) 
 

Duplicate Inquiries Received from the inquirer 
Duplicate inquiries are caused when the inquirer repeatedly clicks the submit button at the end of the 
IRIS customer form. Although the instructions specifically say to click the button just one time, some 
inquirers do it anyway.  Every time they push the button, another inquiry is created.   When this 
occurs, answer one of the inquiries as you normally would.   Manually set the status code of the 
duplicates to ―Solved-Duplicate‖ and then Save. .This will close out the duplicates. Note: If there are 
numerous duplicates, use the Multi-Edit function to set them all to Solved-Duplicate status in one 
action To deal with all the duplicates of a given inquiry, follow these steps: 

1. Select one of the duplicates and take all necessary steps to answer it. 
2. If there is just one duplicate of the original inquiry, open it, set status to Solved-Duplicate 

and then Save and Close. 
3. If there is more than one duplicate, select all of the remaining duplicates by holding down the 

Control key as you click on all of the duplicate inquiries to highlight them. 
4.  Right click and select Open and then Inquiry.  
5. Manually set the status code to Solved Duplicate. 

6. Click Save and Close.   

Creating Duplicate Inquiries; create a duplicate when more than one mailgroup needs 
to address multiple issues in an inquiry 
 
When you receive an inquiry with multiple issues, some of which correctly belong to other mailgroups, 
you can create duplicates. For example, an inquirer submits one inquiry asks about 1) the amount of 
his compensation and 2) asks about the care he received at a specific medical facility, Assume the 
inquiry was sent to the correct Comp & Pen office.  They would keep jurisdiction of the original inquiry 
and then create a duplicate to send to the specific medical facility to address the medical issue.  You 
can repeat this process to create more than one duplicate if the original inquiry contains multiple 
issues needing to be sent to multiple locations for responses. 
 

You can reassign all to the same routing 

destination using the Assigned field 

You can change the status of all of them. 

You can enter the same Response and/or Private Note for all of 
them by clicking the Add button and performing the action. If you 
enter the same response for all of them, you must click on Send on 
Save and then Save and Close (button on upper left). 
 

If you change your mind and just want to close the screen, 

right click on the multi-edit tab and Close the screen. 
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You can initiate this function in one of two ways: (see instructions and screenshots of each 

method below) 
 
1. Unopened inquiry from My Group’s Inquiries screen.  Inquiry to be duplicated is 

highlighted on the inquiry listings on the home screen; double-click on Create Duplicate button or 
single click and choose Inquiry. Do NOT create a duplicate Contact. 

2. Inquiry is open; go to Contacts and Inquiry History tabs. Click on Contacts tab and 
then on Inquiry History for Inquirer subtab.  Click on Create Duplicate button on the Inquiry 
History for Inquirer subtab, NOT on the Contacts subtab. If you create and save a duplicate 
contact record, contact the VA IRIS System Admin Group to fix it immediately. 
 

Unopened Inquiry from My Group’s Inquiries screen. If you know which inquiry needs to 
be duplicated without opening it up:  

1. Highlight the inquiry from the line items by clicking ONCE.  Do NOT double-click to open the 
inquiry. 

2. Click on Create Duplicate and select Inquiry. 

3. A box will open up asking if you want everything copied with the record.  Accept all and Click 
OK. 

4. See remaining steps in Once You Have Selected the Data Items section below.  

 
 
 

 
 
   Inquiry is open; use Contacts tab and Inquiry History subtab  
 
1. Open the inquiry, click on the Contacts tab,  
2. Click on the Inquiry History for Inquirer subtab; you must perform this task using the Inquiry 

History for Inquirer subtab and not any other subtab. 
3. Click on Create Duplicate. 
4. Click on Inquiry 
5. A box will open up asking if you want everything copies to the duplicate.  Accept all the selected 

boxes and click OK. 
6. See remaining steps in Once You Have Selected the Data Items section below.  

 

1. Highlight the specific inquiry from the line items on the 
Inquiry console screen by Clicking ONCE.  Do NOT double-
click to open the inquiry or you will open that inquiry. 
 
 

2. Click on Create Duplicate and  

select Inquiry. 

3. A box will open up asking if you want everything copied 
with the record.  Accept the default with all boxes checked. 
Click OK.  
4. See remaining steps in Once You Have Selected the 
Data Items section below. 
 
 

1. Open inquiry and click on Contacts tab. 

2. Click on Inquiry History for Inquirer subtab; you 
must perform this task using the Inquiry for Inquirer 
subtab and not any other subtab. 

3. Click on Create Duplicate;  
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Once You Have Selected the Data Items using either of the two methods (unopened 

inquiry and opened inquiries), a new screen will open up with all the information duplicated and 
with a new inquiry number.  Note that the subject line starts with ―Copy of‖ followed by the original 
subject line.  Whenever the subject line begins with ―Copy of‖, it means you are looking at 
duplicate inquiry created by a VA IRIS user from inside the system. 
  

 
 
 
 
Do the following on the newly created duplicate: 

1. Change the Assigned field to the mailgroup that will receive the copy. 
2. If necessary ,change the Topic/Subtopic field to reflect the Topic/Subtopic that is 

appropriate for the receiving group. 
3. Do NOT change the status field from Unresolved. NEVER reassign an inquiry to another 

group in Solved status or they will never see it. The status must be other than Solved when 
it is transferred.  
 

     
      Enter a Private Note on the new copy explaining that your group will handle issue(s) 
XXXXX and that you are creating a copy and sending the copy to them to handle issue(s) 
YYYYY. See example below. 

  

5. A box will open up asking if you want everything 
copied with the record.  Make sure all the boxes are 
selected and then click OK. 
6. See remaining steps in Once You Have Selected the 
Data Items section below. 
 

New inquiry number appears on copy of original. 

Enter a Private Note to explain to the new group 
what they need to do and what issue(s) your 
keeping with the original inquiry. 

Change the Assigned group to the new receiving mailgroup.  

Subject line has ―Copy of‖ inserted at the beginning of 
the subject string 

         

 

Do not change the status code. The status must be 
other than Solved when it is transferred or the 
receiving mailgroup will never see it. 

4. Click on Inquiry. 

Change the Topic/Subtopic to selections appropriate 
to the receiving mailgroup.  

 Depending on the Topic or Subtopic, you may 
need to select a VA RO location or a specific 
medical facility. 
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4. Click OK when you have changed the Assigned group, Topic/Subtopic and entered the 

Private Note.  When you click OK, the duplicate will no longer appear on your screen, but it 
won’t be recorded and transferred until you Save or Save and Close the original inquiry. 
 

 
       Next, do the following to the original inquiry that you are keeping: 
 

5. Add a Private Note to the original inquiry that you are keeping. The Private Note should 
say that you have created a duplicate inquiry #xxxx and sent it to mail group xxxxx to handle 
issue YYYY.  See sample text in screenshot. 

 
 

 
 

 
6. When you send a response to the inquirer, be sure to tell him/her that you have 

created a separate inquiry to address issue yyyy and that s/he will be hearing from 
another mailgroup on that issue. 
 

7. Click on Save to keep the original inquiry open on your screen and send the duplicate to the 
receiving mailgroup OR Click Save and Close to close the inquiry on your screen and also 
send the duplicate to the new group. When the duplicate inquiry displays on the inquiry 
console of the receiving mailgroup, the subject line will say ―copy of‖ at the beginning of the 
text in the Subject field. 
 

         .  
 

 
 
 
 
 
 
 
 

Example of a private note: Says what you are transferring, 
what you need receiving group to do, what you are keeping on 

the original inquiry, and original inquiry number. 

Add a Private Note to the original inquiry  

 

Click OK when you have changed the fields and added the 
Private Note for the new mailgroup. 
  

Copy of will display at the beginning of the subject 
line of the line item that is received by the other 
group.  
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Customer Entry on Behalf of Veterans:  Create a New Inquiry for an Inquirer or 
Update an Existing Inquiry  
 
Inquiries are submitted 1) by veterans and other IRIS customers from the Ask A Question link on the 
IRIS home page on the VA Web site or 2) created by VA staff to record, track, and respond to 
contacts that are made via phone contact with call centers and/or walk-in traffic.   
 

Create an New Inquiry 
Note: To create or update a new inquiry, assume the role of person for whom you are creating 
the inquiry, i.e., if the veteran is the inquirer/caller, write as if you are the veteran when you complete 
the customer entry forms; if you are talking to someone other than the veteran, assume the role of the 
spouse, relative, friend, etc., when you enter the customer entry data. 
 
1. Click on the New Button and select Inquiry or click New twice. (Inquiry is the default if 
double clicked.) 

 
2.  Go directly to the Contacts tab; do NOT complete any data fields. The system has 

already assigned a number and assigned the inquiry to your mailgroup. 

 
3.  On the Contact subtab, click Add and then Search Existing. YOU MUST DO A Search  
Existing TO SEE IF THE CONTACT IS ALREADY IN THE IRIS AND/OR IF THERE ARE ANY 
OUTSTANDING INQUIRIES IN THE SYSTEM.   
 

 
 
 
4. When the Contact Search box opens, enter the Contact Last Name and Contact First Name of 
the inquirer, or the email address, etc., and click Search. 

 
 
If there is No Match on the Contact search, the screen return will say ―There are no items to show 
in this view. 

 

3. Go Contacts subtab 
Click Add and then Search Existing.  

No match return.  

2. Click on the Contacts tab on 
the New Inquiry form.  
 
 
 
 
 
 
 
 
 
 

1. Click on New and then 
Inquiry OR double click on 

New 

4. Enter Contact search terms and click Search Existing.  
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If there is no contact match; contact is not in the system  
If there is no contact match, you will create not only a new inquiry, but also a new contact record for 
the person(s) involved in the inquiry.   (If there is a match, skip to the If there is a match section.) 
.Perform the following steps:   
 

1. Click on the New Contact button on the bottom left of the Contact Search box.

 
 

2. Do NOT start filling in data fields.  Go to Contacts tab> Contacts subtab, Then Click on 
Add button and click Add New. 

 
 

3. Complete the New Contact form with details about the inquirer. If the inquirer is also the 
veteran, fill out the veteran information.  (If the inquirer is asking on behalf of the veteran, 
create the veteran’s contact record later. See steps below for adding a second contact to the 
same inquiry). When you’ve entered the information into fields, click OK. 
 

 
 
 
After you click OK, the screen will return to the inquiry input screen. Some of the fields are 
already filled  based on the contact information that you entered. 

 
 

Enter the contact information FOR THE 
INQUIRER.  If the inquirer is also the veteran, fill 

the Veteran info section.  . 

Click on Edit in the Address field 
to enter all the address fields.  

 When you’ve entered the 

information, click OK. 

1.Click on the New 
Contact button.  

 

2. Click on Add button on Contacts tab and click Add 
New 
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4. Fill in the empty fields at the top of the screen; those fields are:  Inquirer the Vet? Subject 
line, Type of Inquiry, Topic/Subtopic (you must select both), Type of Response preferred, 
etc.  NOTE:  The Assigned mailgroup is shown as your own by default. You will need to 
select the correct mailgroup who will handle the inquiry from the Address dropdown as the 
last step before you complete your work and Save and Close.   

 
 

5. If the inquirer is not the veteran but is asking about a veteran, click on Search 
Existing again on the Contacts tab, and search the IRIS database to see if there is a contact 

record for the veteran.  If not, create a New Record again.  Note that the tab says 
Contacts (1); this means that you have created one (1) contact for this inquiry, who is the 
inquirer.   

            
 
(You will have to repeat this process for all the contacts material to the inquiry.  If the veteran 
is the inquirer, there will be one contact.  If someone inquires on behalf of a veteran, there will 
be two.  If someone is representing the dependent of the veteran, there will be three.   BE 
SURE THAT THE RADIO BUTTON IS CLICKED FOR THE INQUIRER.) 
 

6. Complete the New Contact form that opens up by filling in the veteran’s information. 

 
 
   
  The screen will return to the inquiry screen. Two contacts will now be shown; the inquirer is     

the person whose line item is checked by the radio button.  There are now two (2) contacts 
annotated on the Contacts subtab.  Two line items are shown for the contacts. The one with the 
radio button checked is the inquirer and the other is the veteran cited by the inquirer. Do NOT 
change the radio button settings. 

 

 
 

6. Enter the contact information 
FOR THE VETERAN if other 
than the inquirer. 

Click on Edit in the Address field 
to enter all the address fields.  

 When you’ve entered the information 
into fields, click OK. 

Two (2) contacts are now 
annotated on the Contacts 
subtab.  

Two line items are shown for the 
contacts. The one with the radio button 
checked on the far left of the item is 
the inquirer and the other is the veteran 
cited by the inquirer.  

 

5. If the inquirer is asking for/about a veteran, 
Click on Search Existing on the Contact tab 
again. If there is no match, click on New Record 
and enter the veteran’s data. 

4. Fill in the fields at the top of the inquiry that are 
presently blank: Vet is Inquirer?, Type, Subject, 

Topic/Subtopic, Type of Response. 
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7. Click on the Messages tab and then Inquiry Content. 

        
 
      8. The Inquirer Entry mode is selected and is displayed.  Select the method by which the contact 

was made; Phone is default. 

 
 

     9.  Enter the content of the message in the box. You can also click on and Add a Private Note 
if desired.  

            

             
 

10. Select the correct Assigned mailgroup and a subset of the mailgroup. (Subsets must be 
selected for alerts to be sent that the receiving group/person has IRIS traffic.)  If you are not sure 

who has jurisdiction, click on the IRISInfo Website Help tab   which goes 
to the IRISInfo Intranet website, and select the IRIS Participants Dropdown List document.  
This document lists all IRIS mailgroups in order of appearance and provides additional 
information about service areas, etc.  Put your cursor in the text, do a Control+F and enter your 
search term. You will find all instances of that search term.  In addition, if the Topic/Subtopic is a 
VBA business line, you MAY need to select the RO from the dropdown field.  If the 
Topic/Subtopic is Medical Care at a Specific Facility, you will need to select the VAMC location. 
 

 
 

11. If all your work is done, the correct Assigned mailgroup to receive the inquiry is selected, all 
the data fields completed, message entered, etc., and you no longer need to have this inquiry 
open, click Save and Close. 

  
 
Note:  If you need to retrieve this inquiry, you can click on its reference number on the side  
navigation pane to reopen it.   Recent Items shows the last ten inquiries and/or contacts  
that you worked on 

.                

7. Click on the Messages tab and 
then Add >Inquiry Content. 
 

Enter the Inquiry Content in the box.  
 
 

Click Save and Close when all is done and you no 
longer need the inquiry opened on your screen. 

You can also click on Add  to 
enter a Private Note if desired. 
 
 

8. Select the method by which the 
contact was made; Phone is the 
default. 
 

To retrieve any of the last ten items you 
worked on, go to Recent Items and 
click on the desired item.  

Depending on the Topic/Subtopic, you 
may have to select a VBA RO location 
or a VAMC location from the dropdown 
fields. 
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If there is a contact match; contact exists in the system  
 
If there is one exact contact match, the inquiry form will immediately open up with some of the data 
fields already filled with the known contact information.  You must complete the unfilled fields and the 
message content and may need to update the existing contact information. 

 
 
If there are multiple results for persons/contacts having the same name and/or email address, you 
will need to examine the line items that match to determine which existing contact is the right one and 
click on the name.   In the following example, the Last Name only was searched.  There are 8 returns 
for existing contacts with this Last Name.  You will need to determine which one is the correct 
one and select it by clicking on the correct name. 
 

 
 
Once you have clicked on the correct contact, the inquiry form will immediately open up with most of 
the data fields already filled with the known contact information.  You must complete the unfilled fields 
and the message content.   
 
Perform the following steps: 
 

1.  Check the contact information that is filled in on the top of the contact screen to make sure 
the address, phone, etc. is still correct.  If not, make the changes and update the record.  

 
 

2. Click on the Inquiries tab. The tab itself will have a number in parentheses next to the tab 
label that is the number of inquiries that exist in the system for this contact/person. Opening the 
Inquiries tab will display any inquiries that have been submitted for or on behalf of this contact 
name that have not yet been purged from the system.   Inquiries are purged from the system 
when they have in Solved status and inactive for 24 months. In the following example, there is 
one Unresolved inquiry. 
 

 
 

3. Check the inquiries to determine if you need to update an existing inquiry or enter a whole 
new inquiry. Create a new inquiry if the current issue is other than an issue in an existing 

Contact’s Name  

Contact’s Data 

Click on the Inquiries tab.  In this example, there is one existing 
inquiry on record because the tab label says Inquiries (1). 

Inquiry history for this contact. Each 
inquiry found is a line item. 
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inquiry.  Do not re-open an inquiry that has been in Solved status for more than 31 
calendar days; create a new inquiry.  

 Determine if any inquiries listed are germane to the current issue being discussed. 
Double click on the inquiry numbers to open them up to check. 
  

 
 
 
 Update an existing inquiry: 

 
If the inquiry opened on your screen is germane to the issue being discussed and is 
sufficiently current to warrant an update, Add to the existing Inquiry Content. When that 
inquiry is open on your screen, click on Add and Inquiry Content.  

 
 

o Enter the additional content; click OK. The contact screen reappears. 

 
 

o If you have re-opened an inquiry in Solved status, be sure to change the 
status code to Unresolved. An inquiry in Solved status will never be seen by 
the responsible mailgroup. NOTE: If the inquiry has been in Solved status 
for more than 31 calendar days, you must enter a new inquiry if the issue is 
not material to an issue discussed in an existing inquiry. Do NOT re-open any 
inquiries that have been in Solved status for more than 31 calendar days and 
the Solved inquiry was successfully resolved.  

o Click Save and Close on the screen that comes up to save your addition and 
close the inquiry on your screen. 
 

 
 

NOTE: YOU WILL NEED TO CREATE A NEW CONTACT OR FIND THE EXISTING CONTACT 
RECORD FOR EACH PERSON INVOLVED WITH THE INQUIRY USING THIS METHODOLOGY. 

 
 

 Create a New Inquiry for an Existing Contact 
 

If you determine that updating an existing inquiry is not appropriate and that it makes more 
sense to initiate a new inquiry, then you must Create a New Inquiry for the existing 
contact/person by doing the following:   
 

Double click on the inquiry #s to determine if you need to update an existing 
inquiry or enter a whole new inquiry.  

Enter the additional content 

If the Unresolved inquiry is relevant to the issue being discussed, go to 

Add and Inquiry Content to add more content to the existing inquiry.  

Click OK.  

Click Save and Close.  
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1.  Click on the Inquiries subtab for this contact record.  This action will autofill the 
contact information. 
 

 
 
 

2. Click on the Add New button. 
 

 
 

The inquiry form immediately opens up with some of the fields auto-filled from the Contact 
information.  You must complete the unfilled fields on the upper screen except the Assigned 
field (Save the Assigned field for last item before saving and closing).   
 
              3.   Complete these unfilled fields in the upper screen: Inquirer the Vet?, Type of inquiry, 
Subject line, , Type of Response preferred.  The Assigned mailgroup is shown as your own by 
default. You will need to select the correct mailgroup who will handle the inquiry from the Assigned 
dropdown before you complete your work and Save and Close. Do not change the Assigned field or 
the location fields until you are ready to Save and Close.  NOTE:  If the Topic/Subtopic selection is a 
VBA business line OR is a health/medical issue pertaining to a specific facility, you will need to select 
an RO or VAMC location from the dropdown fields. 
 

 
 
 

4. Go to the Messages tab, Click on Add and select Inquiry Content. 

 

Click on the Inquiries subtab of the opened contact 

record.  

Complete the unfilled fields in the upper screen, 

except Assigned or RO or VAMC location. 

Click on Add and Inquiry Content on the Messages tab.  

Click on Add New button in the Inquiries 
subtab.  
 
 
 
tT 
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5. Choose the method by which contact was made with the inquirer and enter the content of 
the inquiry.  Write it as if you were the inquirer. 

 
 
 
6.  Enter a Private Note if you deem it necessary. 
 
 
 
7. Change the Assigned field to the mailgroup that needs to handle the new inquiry; you 
may also need to select a VBA RO location or VAMC location, depending on the 
Topic/Subtopic.        

 .   
 

                                
 
 
If you are not sure what mailgroup has jurisdiction, click on the IRISInfo Website Help tab 

  which goes to the IRISInfo Intranet website, and select the IRIS 
Participants Dropdown List document.  This document lists all IRIS mailgroups in order of 
appearance and provides additional information about service areas, etc.  Put your cursor in the text, 
of that document, do a Control+F and enter your search term. You will find all instances of that 
search term as you scroll through the document. 

 
Mail groups are listed in alphabetical order.   NCA appears at the top, VA organizations are next, all 
VBA organizations begin with VBA, all VHA location begin with VHA.  If it is a VBA Comp and Pen 
destination, pick the subset that says PCT (Public Contact Team), otherwise pick any subset that 
shows ―Responder Group‖ 
  
If you are unsure of areas of jurisdiction, etc., see full listing of all mail groups in the IRIS, the order in 
which they appear, service area information, etc., on the IRIS Participants Dropdown List 
document at http://vaww.va.gov/irisinfo/irisguides.asp. Please create a direct link to this document or 

use the IRISInfo Website Help tab   that opens the IRISInfo website 
directly.   When needed, open up the document, put your cursor in any of the text, do a control+F to 
open a search box and enter your search location.  All occurrences of this term will be found so that 
you can find the correct one. 
 

8. When you have completed the data fields and the inquiry content, selected the correct 
receiving mailgroup in the Assigned field, click Save (saves data but leaves inquiry open on 

Change the Assigned field to the mailgroup that needs 
to handle the new inquiry.   

Choose the method by which contact was made with 
the inquirer. Enter the inquiry content. 
 

 

 

Select the correct Assigned group and its subset.  

Select the VBA RO Location or VAMC Location if 
needed for the selected Topic/Subtopic. Save 

and Close when completed. 

http://vaww.va.gov/irisinfo/irisguides.asp


 75 

your screen) or Save and Close. Save and Close will record the inquiry and transfer it to the 
new mail group for response.  Do NOT reset the status; never transfer an inquiry in Solved 
status. 
 
 

         

 
Create a Duplicate of an Inquiry that you just created 
If the inquiry that you created addresses multiple issues that need to be handled by multiple 
mailgroups and has been Saved to the system, you can create duplicates and send them to the other 
respective mailgroups for handling.  To initiate this process, do the following and then follow the 
instructions in this manual re: Create a Duplicate. 
 
1) If the inquiry is saved and belongs to your mailgroup, it will be listed on you’re My Group’s 
Inquiries screen. You can highlight it by clicking ONCE and click on the Create Duplicate button. 

  
 
2) You can reopen the inquiry that you just created and Saved and Closed to another mailgroup 
by clicking on the item in the Recent Items column on the left navigation pane.  Once it is open on 
your screen, you can create a duplicate by clicking on Contacts tab and Inquiry History for 
Inquirer subtab and then clicking on the Create a Duplicate button. See screenshots below. 

 
 
 
3) If you have created the inquiry and clicked Save but not Save and Close leaving the inquiry open 
on your screen, click on Contacts tab and Inquiry History for Inquirer and then click on the Create 
a Duplicate button.  
 
 

 
 
Go to Create a Duplicate section of this manual for further instructions.                                                 

 

Click Save and Close to record the inquiry and transfer it to 
the new mail group for response.  Do NOT reset the status; 
never transfer an inquiry in Solved status. 

Click on the inquiry that 
you just created in the 
Recent Items column 
and open it up.  

Highlight the line item by clicking once and then click the 

Create Duplicate button.  

Contacts > Inquiry History for 
Inquirer and click on Create 

Duplicate button. 
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Updating a Contact Record (Inquirer and/or Veteran data) 
 
1. Do a Quick Search for the contact. Go to Quick Search. Select Contact Quick Search from the 
dropdown box. 

 
 
2. Enter the last name and first name and/or email address of the contact (inquirer and/or veteran). 

 
 

3.  Edit any of the information that is found on the Contacts tab of an inquiry if a contact record is 
found.  If so, the contact form will open up that displays the contact name at the top left.    

 
 
 
4.  Click Save and Close when edits are completed. 

 
 
 
Summary of Steps to Create an Inquiry 
 
1. Open the IRIS 
2. Double-click New button. 
3. Go directly to Contacts tab to determine if the inquirer exists in the IRIS system. If the inquirer is 
asking about a veteran, always handle the inquirer information first. 
4. Click on Add button in the Contacts tab and then select Search Existing to find the contact 
record, if any. 
5.a  If there is NO record, click on New Contact button on the Contact Search box, When the 
New Contact  form opens up, complete New Contact form and click OK. (If the contact is also 
the veteran, enter that data on the New Contact form also.) The inquiry will open up and will display 
some of the data you entered on the inquiry fields on the upper screen.   
    b. If there is a record, the inquiry screen will immediately open up; the new inquiry upper screen 
will populate with existing contact information.  You can edit the information if it needs to be updated.   
    c. If inquirer is asking about a veteran, do another search in the Contacts tab to see if the 
veteran has a record in the system.  If there is no match, click on Add>New in the Contacts tab 
and enter the data on this individual in the contact form that opens up. This persons’ contact 
information will be added to the inquiry.  If there is a match, the existing contact information will be 
added to the inquiry.  You can edit this information by selecting the person’s name listed on the 
Contacts tab. 

1. Go to Quick Search. Select 
Contact Quick Search from 
dropdown 

2. Enter the last name and first 
name and/or email address of the 
inquirer/contact. 

3. Edit the personal information here. 
You can add a note or attachment 
using the lower tabs of the inquiry if 
necessary. 

4. Click Save and Close when edits are completed. 
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6. Enter the message on the Messages tab, by clicking on Add>Inquirer Entry. 
7. Complete the unfilled fields on the upper inquiry screen: Subject, Type, Type of Response. 
8.  If the receiving mailgroup who will handle the inquiry needs additional information or attached 
documents, add a Private Note using the Add>Private Note selection and add the document(s) 
using the Internal Documents tab. 
9. Determine the correct routing destination and select from the Assigned field dropdown listings.   
Select the correct mailgroup and its subset. Also be sure that the Topic/Subtopic selection is 
appropriate for this inquiry.  Depending on the Topic/Subtopic, you MAY need to select from the 
Locations fields.  Most any VBA disciplines will need the VBA RO Location field selection; any 
Health/Medical for a Specific VAMC will need the VAMC Location selection. 
10. Take an inventory to ensure that all the fields are filled, attachments added, etc.  If all your work 
is done, click Save and Close. This will complete all activities, send the inquiry to the correct 
location, and close out the inquiry on your screen.  

 
 
 
Posting/Updating Standard Text or Answers/FAQs:  
 
Standard Text: Anyone who wants a Standard Text response posted to the IRIS for use by IRIS 
responders should create the response, ensure its integrity (accuracy, spelling, clarity, etc.), forward 
to the appropriate manager(s) for review and approval, and then have that manager send it to the VA 
IRIS System Admin Group via regular e-mail for posting to the IRIS. 
Answers/FAQs: FAQs in the IRIS Knowledge Base should not repeat the specific information found 
on VA’s numerous websites. Those websites are the authoritative sources for specific information.  
FAQs must be generic in nature and point to those Websites as often as possible to prevent a 
disparity of information and to minimize the overhead to maintaining accurate information in more 
than one place.  When a generic statement with a link isn’t possible or is not the best way to proceed, 
more detailed FAQs may be crafted and posted.   New FAQs and corrections to existing FAQs must 
be factually correct and vetted by appropriate management and then sent via regular email to the VA 
IRIS System Admin Group for posting. Those Standard Text responses and FAQs must not duplicate 
Standard Text or FAQ that already exist. 
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IRIS Troubleshooting Questions  
 
1.  How do I log into the IRIS after I have set a bookmark? 

Click on your Start button on the bottom tray of your screen, go to All Programs, select RightNow 
Technologies and click on it. Each designated IRIS mail group member is provided with a 
username and a password that are case sensitive.  Enter these codes in the appropriate boxes on 
the log in screen. 

 
2.  When I click on the link in the alert message, I immediately get Access Denied.  What is     

the problem? 
    This problem is usually caused by entering access codes without regard to the correct case   

sensitivity.  If you have entered your codes incorrectly three times, you will be locked out and will 
need to request an unlock via Outlook mail to the VA IRIS System Admin Group. 

 
3. I can't find my solved inquiries. Where are they? 

Inquiries with different status codes are viewable on different consoles. The My Group’s Inquiries 
home screen displays inquiries whose status codes are other than Solved or Solved-Duplicate. 
You must navigate to your Solved basket.  To do this, click on the big Search button. When the 
search box opens, click on the Status codes for Solved and Solved-Duplicates only.  Then click 
Search.   The new display will be the inquiries in Solved status for the past six months.  To return 
to the open inquiry screen, repeat the same steps using all status codes except Solved and 
Solved-Duplicate and then search again.     
 

4. I did everything right, but the IRIS wouldn't send my response. What’s wrong? 
When you have typed in a response and clicked on Save or Save and Close and then received a 
message that the IRIS couldn’t send the message, it means that the veteran did not provide an e-
mail address to which the response can be sent.   Usually this also means the veteran requested 
an answer by phone or by surface mail as well.  Check the Type of Response field to see how 
the veteran wants to receive his/her reply.   If other then email, you must delete all of your 
response in the response box (click on one character in your response and then click control + A 
to highlight all of the contents of the response box. Then click on delete.   If any characters, 
including space characters, remain in the response box, the IRIS will think that you still intend to 
send a response via the veteran’s e-mail address.  Response by surface mail or phone, then add 
an Private Note in the IRIS saying what you did to resolve the issue.   Then manually set the 
status of the inquiry to Solved and click Save.  The IRIS will record your internal note, change the 
status and move the inquiry to the Solved Console. 
 

5. I had to answer the veteran by phone or by mail because there was no e-mail address to 
send an electronic response (see 3a above)..  I removed the response I typed into the IRIS, 
but it still doesn’t work.  What’s wrong?  

      When you deleted the response that you typed into the response box, all of the characters did not 
get removed. If no letters are showing, it would indicate that a blank space character was not 
deleted.  Be sure to click on the first space of the response box and hit the delete key until you 
are certain that all the characters have been removed 

 
6. An inquiry was simultaneously routed to multiple addresses; how did this happen? 

It is not possible to MANUALLY route an inquiry to multiple locations.  This circumstance       
occurs when a responder has an open inquiry on his/her screen and then the power to their 
computer is lost because the machine is turned off or a power bump occurs.   When the power 
interruption happens, the problem that results is that the inquiry gets forwarded to a host of 
multiple locations.   The software vendor informs us that there isn’t anything that we can do except 
to ensure that everyone has a UPS backup on their systems.  
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7.  Why don’t I get alerts that I have IRIS traffic?   
IRIS traffic is routed via addresses in the Exchange mail system.   Each IRIS destination   must 
have a specifically named Exchange e-mail address.  Those addresses are set up by local 
Exchange administrators and have distribution lists attached to them.   Persons at a given 
location who need to receive alerts that IRIS traffic has arrived at their mail destination should 
have their names individually recorded on that Exchange mailbox distribution list to get alerts. If 
your name isn’t on it, you will not get alerts.  You must also set your Personal Settings to receive 
email alerts and the IRIS System Admins must set up your account to send the alerts to you. If an 
inquiry is reassigned to your mailgroup and a subset of your mailgroup is not selected when the 
new routing destination is selected, you will not get alerts. 
 

8.   My mailgroup is in the IRIS all day and we don’t want alerts. Can the alerts be shut off?   
 Yes, let the VA IRIS System Admin Group know that you don’t want alerts for your group. 

 
9.  Why can’t the veteran open his response to read it? 

Veterans receive e-mail message traffic telling them that VA has responded and telling them to 
click on the link in the message to get to the response.  When they are unable to open up the 
response, it is because of the foibles of their browsers in combination with their screen settings.   
Part of the message with the link also tells them to cut and paste the link into the address field of 
their browsers if clicking on it doesn’t work. This will usually remedy the problem unless they fail 
to capture the entire link.  If their screen settings caused the link to wrap to an extra line, they 
may not capture all of it.   

 
10.  Why do I get duplicate inquiries? 

      Duplicate inquiries are created by veterans and other IRIS customers when they fill out the 
customer entry form and then hit the Submit button more than one time. Every time they hit the 
Submit button, a duplicate inquiry is produced and recorded in the system. We have multiple 
warnings in red type by the Submit button asking them PLEASE not to click it more than once, but 
it still happens.  When you get duplicates, answer one of them as you normally would, and on the 
duplicates, enter internal notes saying that the inquiry is a duplicate, the original was answered 
on (date), manually set it to Solved and Save it. 

 
11.  I’m looking for an inquiry that was Resolved over a year ago and I can’t find it. Where   is 

it? 
      Once an inquiry is in resolved status for 19 months and has had no internal or external activity, it 

is purged from the system.  Any information provided by an IRIS inquiry that is relevant to a claim 
or other transaction that exists in an official hard copy file should be printed out and added to that 
hardcopy file. 

 
12.  Why do we only have five business days to respond to an inquiry? 
       VBA, VHA and NCA made a management decision that five business days is an appropriate time 

frame for response.  
 
13.  Do all inquiries in a status other than Solved or Solved-Duplicate count as open and not 

completed? 
       Yes.  Any inquiry in a status other than Solved, Solved-Duplicate, or Solved—too little info is 

considered open for statistical purposes.  
 
14.  What is the life cycle of an inquiry? 
       The life cycle of an inquiry depends on how long it remains Unresolved.  It is considered alive 

and active until its status is set to Solved.   The life cycle of an inquiry can be reactivated if the 
veteran updates his inquiry at any time within 31 days of the last action taken on that inquiry, 
either internally or externally.   For example, the veteran sends an inquiry.  It is answered.  The 
veteran updates that same inquiry within 31 days of his response, which re-opens it and extends 
it life cycle.  VA answers the updated inquiry.   The veteran comes back and updates the second 
response within 31 days, which reopens it. This type of activity can greatly prolong the life of the 
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inquiry.   Once 31 days have elapsed since the last action, the veteran must submit a new 
inquiry. NOTE: Veterans can also cancel their inquiries by clicking on a button that says ―I no 
longer need a response to my inquiry.  When this happens, the inquiry will be set to Solved and 
moved to your solved basket 

 
 15.  How do I handle nuisance traffic? 
       IRIS mail groups have occasion to receive repeated inquiries from the same individual even 

though all necessary actions have been taken and there is nothing else that can be done.  We 
cannot prevent anyone from using the Internet; nor can we prevent anyone from submitting or 
updating IRIS inquiries.   The policy for handling this dilemma requires the consent of local 
management.  If local management agrees, you can enter a Private Note that says that 
everything that can be done has been done and no further responses will be forthcoming per 
instructions from local management.  (Note:  If a FOIA or other request is received that results in 
VA printing out IRIS inquiries involving a specific inquirer, the internal note may be seen.  Choose 
your words carefully when entering Private Notes. Then you manually set the inquiry to Solved 
and Save and Close it.  Over time, the repeated inquiries are likely to stop. 

 
16.  How do we handle FOIA Requests? 

The Freedom of Information Act (FOIA) requires that the agency must initiate action/route all 
requests for agency records within 10 days of having received it and that the agency will now be 
responsible for attorneys’ fees if the requester successfully sues the agency.  The agency can be 
sued for failing to respond to a FOIA request within the statutory time frame (usually 20 days). 
 
If something regarding FOIA comes through the IRIS, please be advised of the following: 
The request for records does not have to say ―FOIA request‖.  ANY request for AGENCY records 
is a FOIA request. (NOTE: this is not the same as an individual asking about his/her own 
records.)  If you get an IRIS that contains ONLY a request for agency records, please notify your 
Privacy Officer immediately and let the inquirer know that all FOIA requests must be mailed or 
faxed with an original signature.   
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Analytics/Reports Basics 
 
The following discusses how to get to the Reports function and demonstrates how to set parameters 
and schedule reports.  A complete discussion of the Analytics/Reports function is contained in 
the vendor manual that is available at http://vaww.va.gov/irisinfo/irisguides.asp . 
 

 
Navigating to Analytics/Reports 
 
To access the Analytics/Reports function, click on the Analytics button near the bottom of left-hand 
pane (only available to IRIS users with Analytics/Reports access). 
 

 
 
When you click on the Analytics/Reports button at the bottom of the pane, your choices AT THE 
TOP OF THE PANE change.  You will see the header, Analytics/Reports and can choose the 
Reports subset. 

 
 
You will then see the Reports Explorer console. 

 
 
The most commonly used reports are in the Service report folder; you can expand this folder to see 
all the available reports subsets and click on the plus signs to see their subsets. The list of service 

Analytics/ 
Reports 

Function 

Analytics/Reports becomes the top Explorer 
section on the left navigation pane. 

The Reports Explorer screen 
will display. 

Click on Reports  

Available Reports folders will display.  
Not all reports are available to everyone. 

http://vaww.va.gov/irisinfo/irisguides.asp
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reports reflects the most commonly used standard reports, such as Inquiry Reports and Responder 
Reports.  

 
Service Reports 
 

 
 
The most often used report is Open Inquiries>Group> Last Updated.  The last update parameter 
calculates on the most recent activity, which is not necessarily the date of creation.  Be sure to select 
the parameter that reflects the specific types of data that you are looking for. This report is used for 
the following example.  See following screens.    
 

 
 
The systemwide data for all groups will then display on the screen.   
 

 
 
 

Inquiry Reports  

The most 
often used 
report is the 
Open 
Inquiries 
report, using 
Group and 
the Last 
Updated 
parameter on 
the right side 
of the screen. 

Click on Last 
Updated by Group 
parameter.  . 

The Report Title is shown at the top of the screen. 

Responder Reports  
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If you are granulating the report and setting parameters, in the Search box, do the following: 
1. Select the Group(s) you are interested in (Logged In is your mailgroup); click on Select All 

to de-select all the mailgroups; hold down the control key to select specific groups. 
2. Accept the defaults for Type, Topic and Status, etc. 
3. Click on Search 

.  
 

 
The results display in both graph and in tabular form and will reflect the information at the moment 
you pulled the report.  Data in blue font have drilldown capability.  
You can click on the data to see further granulation. 
 

  
  
Reports Displays: 
 Once you have displayed the report on your screen, you can adjust how it appears by using tools 
available on the home screen ribbon or contained in the tabs.. 

 

Results are displayed in both graph 
and tabular form. 

Select the group(s) from Group 
Name parameter field and 
accept all other defaults. 

Click Search. 

Data in blue font have drilldown 
capability by clicking on the data item.  

Buttons on the  right end of 
the ribbon are available for 
users with Reports 
permission to adjust reports 
results. 
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For exact instructions on reports, please see vendor documentation about 
analytics/reports posted at http://vaww.va.gov/irisinfo/irisguides.asp . 

 
 
Creating a New Report –NOT RECOMMENDED.   

 
The existing standard reports should be sufficient for most needs.  You may use ANY report that is 
visible to you on your Reports Console, so be sure that what you are looking for doesn’t already exist.  
Creating a new report puts the burden on you to totally construct the report, the visual layout, column 
sizes, fonts, all of the variables, etc.  See the complete Analytics manual from the vendor which is 
posted at http://vaww.va.gov/irisinfo/irisguides.asp . 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Home tab displays the 
report.  

Display tab allows the user to change the appearance of the report results.  

Page Setup tab allows the user to change the appearance of the report itself.  

http://vaww.va.gov/irisinfo/irisguides.asp
http://vaww.va.gov/irisinfo/irisguides.asp
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Service Glossary  
 
Access level—A method of controlling which public answers are visible on the IRIS administration 
and end-user interfaces. The default access levels is Everyone, which means that the FAQs/answers 
are displayed to the public and to VA employees.  
Administration interface—All of the consoles, panels, and windows used by administrators and staff 
members to configure, manage, access, and work with an IRIS application.  
Administrator—A staff member who configures, customizes, and maintains an IRIS application.  
Analytics/Reports Console—The console where staff members can access standard reports and 
create custom reports. Reports can be customized using filters, comparison periods, trending 
analysis, graphical display, and output. Staff members can also subscribe certain staff members, 
groups, and email addresses to particular reports through the Analytics/Reports Console.  
Announcements box—A white board or memo box that can be displayed on the IRIS Home page to 
make special announcements to veterans. This tool is used only on rare occasions by the IRIS 
System Administrators, usually to announce that the IRIS will be temporarily out-of-service due to 
emergency maintenance. 
Answer/FAQ Knowledge Base—A list of all Frequently Asked Questions that have been entered 
into the IRIS by subject matter experts or their designees.   The FAQs are indexed with VA’s 
corporate search engine.   
Answer/FAQ—Any knowledge base information in FAQs that provide answers to common questions 
from veterans and other IRIS customers.  
Answer/FAQ/ Console—The console in the IRIS for adding, managing, and organizing answers that 
can be made available to veterans and other IRIS customers.  
Answer/FAQ status type—The status of an answer that determines whether it can be viewed by 
veterans and other IRIS customers. The default answer status types are Public and Private.  
Ask a Question—A link on the IRIS Home page that veterans and other IRIS customers can click to 
submit a question when they cannot find an answer in the FAQ knowledge base. 
Audit log—A list of all the actions taken on a record in the FAQ/knowledge base, including who 
performed the action, what the action was, and when the action was taken.  
Business rules—A component in the IRIS for defining processes that automate workflow, 
notification, and escalation. Business rules can be defined to automatically route incoming inquiries to 
the appropriate responders; escalate inquiries, update inquiries and update FAQs/  
Category—Changed to Type for VA’s usage.  This term applies to the type of inquiry, which can be 
compliment, complaint, suggestion, question, etc. 
Console—A major display window such as the Inquiry Console and the FAQ/Answer Console. 
Dashboard—An option in the IRIS for viewing the Operations Dashboard report in the IRIS. This 
report shows new inquiry activity, solved inquiry activity, backlogged inquiries, open inquiries, and 
viewed end-user pages.  
Database—The tables and data structure in an IRIS application that maintain, store, and retrieve 
information.  
Discussion thread—The list of all activity on an inquiry, including updates made by the end-user, 
responses entered and/or sent by responders, and notes about the inquiry made by responders 
(never visible to veterans and other IRIS customers). All activity is listed chronologically and provides 
a history of each inquiry in the knowledge base.  
Display position—The position where a new FAQ/answer appears on the Find Answers page. 
Options include Historical Usefulness; Place at Top, Middle, or Bottom; Fix at Top, Middle, or Bottom. 
The display position is selected from the Display Position drop-down menu on the Answer Console.  
Disposition—See Inquiry disposition.  
Distribution list—A mailing list of non-staff member email addresses used for scheduling reports or 
any mailing event.  
Drag-and-drop—A feature for moving an element or object in a hierarchy.  
Drill down—To start at a top or general level and become more specific at each lower level. The IRIS 
drill-down feature enables access to additional levels of detail on consoles, views, and reports.  
Drill-down link—A link on a view grid for drilling down to the next level.  
Email message—An email message that is automatically sent by the IRIS to veterans and other IRIS 
customers. The sending of email messages is triggered by events in the IRIS; for example, when a 
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veteran submits a question in the IRIS, the Question Receipt message will be sent to the veteran’s 
email address telling him or her that VA has received their inquiry and will respond within 5 business 
days. 
End-user—A veteran or other IRIS customer who accesses the IRIS end-user interface to look up 
and view answers or ask a question.  
End-user interface—All of the pages in the IRIS that veterans and other IRIS customers can access 
to look up answers and ask a question.  
Entry Setup window—The first window that opens after entering the IRIS administration interface 
URL in a Web browser. From this window, staff members can add a bookmark to their Web browser 
for the IRIS administration interface and also launch their IRIS application.  
Everyone access level—An access level designed to allow answers to be visible to all staff 
members and veterans and other IRIS customers depending on the answer status.  
File attachment—A VA file that is attached to an inquiry, answer, organization, or opportunity, or 
sent with an inquiry response. Files that are attached to an inquiry response can be accessed by 
viewing the answer. Sending a file with an inquiry response is a one-time function that attaches a file 
to the response. Veterans and other IRIS customers can access the file directly from their email 
client.  
File Manager—The interface used to access modifiable files for IRIS modules.  
Find Answers—A link on the IRIS Home page that opens the Find Answers page where veterans 
and other customers can view FAQs/Answers and search the knowledge base. Veterans and other 
customers can click an answer to view the complete details or search the knowledge base using 
drop-down menus to narrow their search. If enabled, veterans and other IRIS customers can also use 
the Browse search method to search the knowledge base by topics or Web Indexer to search Web 
sites or as an alternative search for answers. See also Browse and Web indexer.  
Group—A mailgroup set up in the IRIS to receive inquiries from veterans.. 
Inbox—A responder mailgroup’s list of inquiries. The inbox contains all inquiries that have been 
assigned to the responder mailgroup. 
Inbox limit—The maximum number of inquiries in a responder’s inbox that cannot be exceeded. 
Inquiry—Any question or request for help from a veteran or other IRIS customer using the Ask a 
Question feature of the IRIS.  
Inquiry archiving—A process that permanently removes inquiries from the database. Archived 
inquiries are then stored in searchable data files that can be viewed from the Contact tab. if the 
veteran has sent more than one inquiry from a single e-mail address in the past year. 
Inquiry Console—The console in the IRIS for adding, editing, viewing, and responding to inquiries, 
and adding and maintaining contact and organization records. The Inquiry Console tracks all inquiries 
generated by veterans and other IRIS customers through any source. Also called responder interface.  
Inquiry disposition—A feature for classifying inquiry resolution. Any number of dispositions can be 
defined to precisely record how inquiries are resolved. Also called disposition.  
Inquiry Home—Also known as the IRIS home page. that contains links leading to the main functions. 
This page provides veterans and other IRIS customers with quick access to the tools they need to 
answer their questions and receive immediate customer service.  
Inquiry status and status types—The current state of an inquiry. The inquiry statuses in the IRIS 
are Unresolved, Solved, Updated, Waiting for Contact, Additional Information Provided (occurs 
automatically when a veteran updates an existing inquiry), and Additional Information Requested and 
others added for VBA purposes. 
Interface—The consoles, panels, windows, and pages used by staff members, veterans and other 
IRIS customers to access an IRIS application and interact with a single knowledge base. The 
interface name determines the URL for the Web site, the name of the IRIS executable, and the .cfg 
directory name.  
IRIS—VA’s Inquiry Routing & Information System, the mechanism by which veterans and other VA 
Web customers can find answers to Frequently Asked Questions and submit and route inquiries to 
VA. The IRIS assists customer service and inquiry organizations that need to easily capture, respond 
to, manage, and track all service interactions in one consolidated application. 
IRIS Component Manager—An IRIS application that verifies that the inquiry files (or  
components) required to run the administration interface are installed and up-to-date. The 
Component Manager automatically runs prior to logging in to the administration interface. 
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IRIS components—Inquiry files, such as the IRIS executable, that are installed on 
staff members’ workstations. IRIS components are partially responsible for the functionality of 
features such as the Analytics/Reports Console, expression validator, spell checker, and color layout. 
See also IRIS Component Manager. 
keywordindexer—A utility that creates an index of the keywords found in inquiries, answers, file 
attachments, and documents indexed by the Web Indexer. The keyword indexes are used when 
searching inquiries, answers, file attachments, and other indexed documents. See also Web indexer.  
Login—The action required to get into the IRIS using a username and a password.  
Login window—The window that staff members open after entering the IRIS at 
https://iris.va.gov/scripts/iris.exe/login. From this window, staff members must type their login name 
and password to access their IRIS inquiries. 
Mailbox—An Exchange mailbox specified in the IRIS as a routing destination that collects IRIS 
inquiries sent by veterans and other customers. 
Multi-select—A feature on a number of consoles for updating more than one record at a time.  
Navigation area—The right side of the top row of the toolbar containing buttons for accessing other 
IRIS modules that are enabled, common consoles, Help, and the Links menu.  
Page—A Web page; an end-user page in the IRIS application.  
Permissions—A component of views that determines which security profiles have the ability to run or 
edit a view.  
Private—One of two default answer status types.  FAQs/Answers marked Private are never visible to 
veterans or other IRIS customers.. 
Profile—A mechanism for controlling access to administration functions and for assigning staff 
members specific permissions, views, and report access.  
Propose answer—A function for proposing an FAQ/answer from an inquiry. A copy of the inquiry is 
created as an FAQ/answer and can be viewed and edited from the FAQ/Answer Console. The 
knowledge base engineer then determines its access level, status, language, and visibility.  
Proposed—One of four default answer statuses. This answer status indicates that the FAQ/answer 
has been proposed by a staff member from an inquiry. Answers with a Proposed status are not visible 
to veterans and other IRIS customers.  
Public—One of two default answer status types. FAQs/Answers marked Public may be visible to 
veterans and other IRIS customers depending on their access level and language.  
Resolution time—The maximum allowable time (in hours) set by a service organization for resolving 
inquiries. 
Responder—A VA staff member who is responsible for answering inquiries sent to their IRIS 
destination 
Response time—The maximum allowable time (in hours) set by a service organization for initially 
responding to new inquiries.   Inquiries should be answered within 5 business days of receipt in the 
IRIS. 
Review—This status can be used to notify the knowledge base engineer when a public answer in the 
FAQ/Answer Knowledge Base needs to be reviewed.  
Search index—A matrix that includes a list of important words within a document and their document 
of origin, allowing efficient searching. In some cases, the matrix is a database table; in other 
instances, the matrix is a file stored on a hard drive. For a word phrase to be searchable within an 
inquiry, answer, file attachment, or external document, it must first be indexed.  
Session tracking—A feature that tracks IRIS customers’ current session history; that is, the pages 
on the end-user interface that the veteran clicked before submitting a question.  
SmartAssistant—IRIS technology that assists the IRIS veterans and other IRIS customers and staff 
in finding and suggesting possible solutions to a question or issue based on the current session 
history or the keywords in an inquiry’s discussion thread. See also Suggested answers.  
Solved—One of the inquiry status types; an inquiry marked Solved has been resolved and closed.  
Solved count—The method for determining where an FAQ/answer will display in the list of answers. 
The most useful answers (those with the highest solved count) are pushed to the top of the list, while 
those with the lowest ratings are moved down on the list.  
Staff account—The settings for a staff member/mailgroup authorized to access an IRIS application, 
including login name, password, profile, group assignment, and email information.  
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Staff member—Any employee with a staff/mailgroup account and profile authorized to access an 
IRIS application.  
Standard text—Any text or response prepared in advance that can be sent to veterans and other 
IRIS customers when responding to IRIS inquiries, appended to responses by a business rule. Also 
called standard response. See also Response folder and Content library.  
Suggested answers—A feature in the IRIS that suggests answers to veterans and other IRIS 
customers’ questions when a business rule has been set up to append SmartAssistant suggested 
answers on email and Ask a Question inquiries. Veterans and other IRIS customers can click a 
suggested answer to view a possible solution. Suggested answers are also available to responders 
on the Inquiry Console when editing inquiries.  
Tab set—A group of panels on a console that each contain information associated with the record 
being added, edited, or viewed. The tab set design enables easy access to the information on each 
panel by clicking the associated tab.  
Text searching—A feature in the IRIS that enables veterans and other IRIS customers and staff 
members to search using their own words instead of choosing values from specific fields. The 
entered text is compared to the indexed keyword phrases for answers and keywords for inquiries to 
locate similar keyword phrases. 
Toolbar—The bar across a console or window in an IRIS module containing buttons for performing 
console-specific functions and accessing any IRIS module that is enabled, common consoles, Help, 
and the Links menu. 
Topic—A classification assigned to answers and inquiries. Inquiries can be classified under one main 
topic and up to five lower-level topics; answers can be classified under multiple main topics and up to 
five lower-level topics for each main topic. 
Topic word—A word that is associated with an answer or document. The associated answer or 
document will always be displayed to veterans and other IRIS customers when the topic word is 
included in their search text. 
Unresolved—The status code of an inquiry that has yet to have any definitive action taken on it. 
Updated—The status code of an existing inquiry that has been updated by the veteran. 
View—A unique display of information customizable for certain the IRIS consoles and the IRIS end-
user search pages. A view specifies the search options available (fixed and run-time selectable filters) 
used to select particular groups of records and the output columns that will be displayed.  
View grid—The output columns of the currently selected view on an IRIS console and the search 
pages on the IRIS end-user interface. See View.  
Waiting for Contact—A inquiry status code that must be manually set by an IRIS responder.  This 
code is used when the responder is trying to reach the inquirer by phone and is continuing to try using 
the telephone.  
Web indexer—A search method in the IRIS that allows veterans and other IRIS customers to 
simultaneously search the knowledge base along with VA Web pages.  
Web spider—A software application that reads Web pages and other documents and indexes the 
content for a search engine, often following hyperlinks from one Web page to another.  
Word stemming—A feature used in keyword indexing and text searching that finds the root of each 
word and stores the stemmed root instead of the whole word, thereby saving large amounts of space 
while making a search broader and more appropriate.  
WYSIWYG--what you see is what you get.  

 


